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INTRODUCTION 
Before Getting Started:  

Please read the entire manual before using the software. 

About AVL 
AVL Looms has been in the business of designing and building some of the 
world’s finest handweaving looms since 1977. 

Jim Ahrens had been building and designing looms for a number of years 
before Jon Violette, the “V” in AVL, approached Ahrens about a partnership 
in 1977.Violette, an industrial management professional, had discovered 
Ahrens’ work through his sister who ran the Pacific Basin School of Textiles 
in Berkeley, where Ahrens was a volunteer advisor. 

The two men worked together in the Bay Area for three years until Violette 
moved Ahrens and Violette Looms to Chico, where it officially became known 
as AVL Looms Inc., and has operated ever since. 

In 1982, Violette was instrumental in the development of the first 
computerized dobby, then called the “Apple Dobby”. He retired from active 
life in the company in 1987. 

Once known for our production looms, AVL has broadened its line 
considerably and we now offer customers a full spectrum of fine weaving 
equipment, ranging from our small Home Looms, to our Industrial Dobby 
Looms, Rug Looms, and Jacquards. 

The Compu-Dobby 5 Design Concept 
The guiding concept behind the Compu-Dobby 5 is ease of use with precise, 
repeatable control. The loom is designed to be easy to thread, easy to setup 
and easy to weave on. 

LOOM FEATURES 

Compu-Dobby® 

A first for handweaving looms, the Compu-Dobby 5 enables computer 
control of pattern and key loom functions, including warp tension and pick 
spacing. 

Pattern control is a state of the art system that eliminates the multi-treadle 
dance of traditional looms and the tedious pegging of mechanical dobby 
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looms. Much like the legacy cartridge systems from the Compu-Dobby I and 
II, the Compu-Dobby 5 stores entire weaving files (WIFs) onboard with three 
significant advantages over all other systems: 

 Ultra-fast pick writing. The system can achieve weaving speeds 
in excess of 100 picks per minute. 

 Hundreds of weaving files may be stored for later use. 

 Eliminates latency timing issues inherent in computer 
communications systems. Latencies can cause slower weaving 
and even missed picks. 

As a web enabled device, this loom connects to your computer or tablet via 
WiFi or USB and controls the loom from your favorite browser. AVLDrive 
version 5 is an easy to use, intuitive interface run from within the Compu-
Dobby 5. As a direct result, there is no software to install for the loom, nor 
limitation on the controlling device, except for a minimum screen resolution 
(1024 x 768 pixels). AVLDrive is compatible with all major browsers, including 
Safari, Chrome, Edge, Firefox and Opera. The current version of the browser 
should be used. 

Warp Beams and Automatic Warp Tension System  
Another first in our industry, some looms offer digital control of warp tension 
using a small electrical motor and drive system connected via spring and 
brake cable to the warp beam. The motor is controlled by the Compu-Dobby 
& AVLDrive. Easily change the warp tension at any time during weaving by a 
click of the mouse or a touch of the finger on the touchscreen. This system 
allows very fine, repeatable control with a range from locked beam to free 
turning for winding on the warp. 

Automatic cloth advance is an AVL-only feature on hand weaving looms. 
Earlier mechanical versions of these systems are well known for providing 
fine control over pick advance spacing. This feature utilizes digital controls 
via an electric motor driven worm and gear attached directly to the cloth 
beam. Much like the digital warp tension controls, set the picks per inch in 
AVLDrive and start weaving. Easily change the advance setting or manually 
advance the cloth at any time during weaving by a click of the mouse or a 
touch of the finger on the touchscreen. This system allows very fine, 
repeatable control with a range from hundreds of picks per inch (or 
centimeter) to gross movements needed when starting a new warp.
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CONNECTING TO 
THE LOOM 

ATTENTION:  
Please read through this entire section before powering on your loom. 
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CONNECTION TYPES 
In order to connect to the loom, your device must either have a USB port or 
the ability to connect to the internet. There are three ways to connect a 
device to the loom: 

Connection Type Description 

USB  USB cable from your device to the loom. Only 
devices with USB ports can connect this way.  

LAN (Local Area 
Network) 

Through a router. Only devices with WiFi can 
connect this way. 

LoomDirect Connection to the loom’s local WiFi network 
(not through a router). Only devices with WiFi 
can connect this way. 

 

The software interface (AVLDrive) is web browser based so you do not need 
to download anything. Simply open your standard web browser (Chrome, 
Safari, Firefox, etc.) and type in the loom’s address. 

When the loom is started, it will try to connect to the router (LAN) it is 
normally connected to first. If it cannot find the router, it will start 
LoomDirect. The USB connection is always available. 

LOOM MODES 
The loom is designed to be controlled through the AVLDrive software, so 
there is no “power” button anywhere on the loom. 

We recommend the use of a good surge protector between the outlet and UPS 
on the Compu-Dobby 5, especially in regions subject to lightning strikes and 
other extreme electrical anomaly incidences. In areas prone to brown/black 
out or power grid fluctuations, we recommend a 800W, 1000VA UPS for 
Compu-Dobby 5 equipped K-Series. 

Standby Mode: 
When you plug the loom in it enters Standby Mode. The loom is designed to 
be left plugged in and in Standby Mode at all times. In standby power mode, 
the loom consumes very little power, and maintains the network connection 
to the router or LoomDirect WiFi. 
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Note:  
Avoid pulling the power cord while the loom is in standby power mode. 
Please use the Shutdown menu option to completely power down the loom 
prior to pulling the power cord from the electrical socket. 

Weaving Mode: 
Weaving mode is when the loom and all its digital controls have been 
powered on through AVLDrive. You will hear the warp tension motors set 
into place and other digital features come to life.  

WARNING:   
Do not pull or cut power to the loom while in Weaving mode.  

Shutdown Mode: 
This mode allows you to shut down the loom properly so that power can be 
removed. It can be initiated from Weaving Mode or Standby Mode through 
AVLDrive. Shutting down the loom through AVLDrive is the proper way to 
stop all power to the loom. Once the loom has been shutdown the power 
cord can be unplugged. 

If the loom has been Shutdown through the software, but is still plugged in, 
simply unplugging it and plugging it back in will initiate Standby Mode.  

POWERING ON THE LOOM 
When powering on the loom for the first time, you will need to use either a 
USB connection or connect via LoomDirect. In order to connect via a router 
(LAN), you will have to setup the Network information on the loom using one 
of the other connection types first. Once setup you can then connect via 
router each time you come to the loom. However, if Wifi connections are 
ever lost you can always revert to USB or LoomDirect. 

1) Connect the loom to power via the provided power cable. All lights 
but the “Error” light will light up as shown in the images below. 
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2) Wait for the loom to bootup. This may take up to several minutes. 
Once ready the loom will show just the “Power” and “Network” 
lights. The network light may be Green or Red. 

 

LED Lights 
The loom uses a lighted interface for communication with the weaver. 

Light Name Description 

POWER Orange light means “power” to the loom in standby mode. 
Red light means “power” to the loom in weaving mode. 

NETWORK Different colors indicate the network status. 
Blinking Red: searching for a router. 
Red: connected to a router 
Green: LoomDirect is available (not searching for a router). 

COM Green light shows the loom is connected to a device. No light 
means there is no device connected.  

ERROR Red light will shine when an error has occurred.  

SHED Red light will shine when shed open. Green light will shine 
when shed closed. If the dobby is in between states (shed 
null), it will be unlit. 
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Connecting via USB
When using a USB, a cable is attached from your device to the loom. 
are not using the USB connection, remove the cable from the device.

1) 

2) 

3) 

Note:  
Any time you’re connected via USB you can use 
name
connected to the loom and the device, the loom will default to using the USB 
cable, even if a network connection is setup.

4) 
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Connecting via USB
When using a USB, a cable is attached from your device to the loom. 
are not using the USB connection, remove the cable from the device.

 Plug the normal USB plug into your 
into the 

 Open an Internet browser program on your 
Internet Explorer,

 In the Address Bar, type in 
192.168.7.2 when using a Windows PC
AVLDrive
USB. You can also use the Loom Name URL once it has been setup.

 
Any time you’re connected via USB you can use 
name to open 
connected to the loom and the device, the loom will default to using the USB 
cable, even if a network connection is setup.

 When the 
COM light indicates only that a device is connec
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TTING UP COMMUNICATI

Connecting via USB 
When using a USB, a cable is attached from your device to the loom. 
are not using the USB connection, remove the cable from the device.

lug the normal USB plug into your 
the Compu-Dobby.

Open an Internet browser program on your 
Internet Explorer,

In the Address Bar, type in 
192.168.7.2 when using a Windows PC

rive. This is the IP address for the loom when connecting via 
You can also use the Loom Name URL once it has been setup.

Any time you’re connected via USB you can use 
to open AVLDrive. If the loom name is entered

connected to the loom and the device, the loom will default to using the USB 
cable, even if a network connection is setup.

the device is connected
COM light indicates only that a device is connec

 

 

TTING UP COMMUNICATI

When using a USB, a cable is attached from your device to the loom. 
are not using the USB connection, remove the cable from the device.

lug the normal USB plug into your 
Dobby. 

Open an Internet browser program on your 
Internet Explorer, Microsoft

In the Address Bar, type in 
192.168.7.2 when using a Windows PC

This is the IP address for the loom when connecting via 
You can also use the Loom Name URL once it has been setup.

Any time you’re connected via USB you can use 
. If the loom name is entered

connected to the loom and the device, the loom will default to using the USB 
cable, even if a network connection is setup.

device is connected
COM light indicates only that a device is connec

 

 

TTING UP COMMUNICATION 

When using a USB, a cable is attached from your device to the loom. 
are not using the USB connection, remove the cable from the device.

lug the normal USB plug into your 

Open an Internet browser program on your 
Microsoft Edge, Firefox, Opera

In the Address Bar, type in 192.168.
192.168.7.2 when using a Windows PC

This is the IP address for the loom when connecting via 
You can also use the Loom Name URL once it has been setup.

Any time you’re connected via USB you can use 
. If the loom name is entered

connected to the loom and the device, the loom will default to using the USB 
cable, even if a network connection is setup.

device is connected, the COM Light will 
COM light indicates only that a device is connec

 

 

When using a USB, a cable is attached from your device to the loom. 
are not using the USB connection, remove the cable from the device.

lug the normal USB plug into your device and p

Open an Internet browser program on your device
Edge, Firefox, Opera

192.168.6.2 when using a Mac or 
192.168.7.2 when using a Windows PC and press Enter

This is the IP address for the loom when connecting via 
You can also use the Loom Name URL once it has been setup.

Any time you’re connected via USB you can use the IP address or the loom 
. If the loom name is entered, and a USB cable is 

connected to the loom and the device, the loom will default to using the USB 
cable, even if a network connection is setup. 

COM Light will 
COM light indicates only that a device is connec
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When using a USB, a cable is attached from your device to the loom. 
are not using the USB connection, remove the cable from the device.

and plug the other end 

device (Chrome, 
Edge, Firefox, Opera, etc.).

when using a Mac or 
and press Enter

This is the IP address for the loom when connecting via 
You can also use the Loom Name URL once it has been setup.

the IP address or the loom 
, and a USB cable is 

connected to the loom and the device, the loom will default to using the USB 

COM Light will come on
COM light indicates only that a device is connected. 
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When using a USB, a cable is attached from your device to the loom. If you 
are not using the USB connection, remove the cable from the device. 

lug the other end 

(Chrome, 
). 

when using a Mac or 
and press Enter to open 

This is the IP address for the loom when connecting via 
You can also use the Loom Name URL once it has been setup.

the IP address or the loom 
, and a USB cable is 

connected to the loom and the device, the loom will default to using the USB 

 

come on. The 
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If you 

lug the other end 

to open 
This is the IP address for the loom when connecting via 

You can also use the Loom Name URL once it has been setup. 

the IP address or the loom 

connected to the loom and the device, the loom will default to using the USB 

The 
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Connecting via LoomDirect 
LoomDirect means the loom is generating its own WiFi network and will 
show up as an available network on your device. The great part about this 
feature is that you don’t need to be actively connected to the internet to 
wirelessly connect to the loom. However, your computer must still have the 
capability to connect to the internet. 

The loom’s protocol is to first search for a router to connect to. If it does not 
find one, it will automatically switch to LoomDirect and create its own 
network. 

Note: 
If no router (LAN) connection is established your loom will automatically 
switch to LoomDirect.  

1) Wait for the loom to switch to LoomDirect and the private network 
to show up on your device. This should occur quickly. 

2) When the Network light shines green, the loom is now putting off its 
own network that can be found from your device.  

3) The network will be AVL_[loom_serial_number] where 
loom_serial_number is the serial number for your loom. 

4) Connect your device (laptop, tablet, phone) to this WiFi network.  
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5) 

6) 

Note: 
If the loom name is entered, and a USB cable is connected to the loom and 
the device, th
connection is setup.

7) 

8) 

Note: 
If you switch to a new device, you will need to connect to LoomDirect 
new device
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 The password for the network will be CompuDobby5.

 Open your browser and type in 
loom if you’ve named it

If the loom name is entered, and a USB cable is connected to the loom and 
the device, the loom will default to using the USB cable, even if a network 
connection is setup.

 When the device is connected
COM light indicates only that a device is connected.

 Once you establish the LoomDirect connection you won’t hav
through this process again. You can shut down your loom and you’ll 
be able to turn the loom on and connect to 

If you switch to a new device, you will need to connect to LoomDirect 
new device and enter the Netwo
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The password for the network will be CompuDobby5.

Open your browser and type in 
loom if you’ve named it

If the loom name is entered, and a USB cable is connected to the loom and 
e loom will default to using the USB cable, even if a network 

connection is setup. 

the device is connected
COM light indicates only that a device is connected.

Once you establish the LoomDirect connection you won’t hav
through this process again. You can shut down your loom and you’ll 
be able to turn the loom on and connect to 

If you switch to a new device, you will need to connect to LoomDirect 
and enter the Netwo

 

 

The password for the network will be CompuDobby5.

Open your browser and type in 
loom if you’ve named it.  

If the loom name is entered, and a USB cable is connected to the loom and 
e loom will default to using the USB cable, even if a network 

the device is connected
COM light indicates only that a device is connected.

Once you establish the LoomDirect connection you won’t hav
through this process again. You can shut down your loom and you’ll 
be able to turn the loom on and connect to 

If you switch to a new device, you will need to connect to LoomDirect 
and enter the Network ID and password.

 

 

The password for the network will be CompuDobby5.

Open your browser and type in 192.168.

If the loom name is entered, and a USB cable is connected to the loom and 
e loom will default to using the USB cable, even if a network 

the device is connected, the COM Light will 
COM light indicates only that a device is connected.

Once you establish the LoomDirect connection you won’t hav
through this process again. You can shut down your loom and you’ll 
be able to turn the loom on and connect to 

If you switch to a new device, you will need to connect to LoomDirect 
rk ID and password.

 

 

The password for the network will be CompuDobby5.

192.168.16.2, or the name of the 

If the loom name is entered, and a USB cable is connected to the loom and 
e loom will default to using the USB cable, even if a network 

COM Light will 
COM light indicates only that a device is connected.

Once you establish the LoomDirect connection you won’t hav
through this process again. You can shut down your loom and you’ll 
be able to turn the loom on and connect to AVLDrive

If you switch to a new device, you will need to connect to LoomDirect 
rk ID and password. 

 Connecting to the Loom

 

 

The password for the network will be CompuDobby5. 

, or the name of the 

If the loom name is entered, and a USB cable is connected to the loom and 
e loom will default to using the USB cable, even if a network 

COM Light will come on
COM light indicates only that a device is connected. 

Once you establish the LoomDirect connection you won’t hav
through this process again. You can shut down your loom and you’ll 

AVLDrive automatically. 

If you switch to a new device, you will need to connect to LoomDirect 
 

Connecting to the Loom
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, or the name of the 

If the loom name is entered, and a USB cable is connected to the loom and 
e loom will default to using the USB cable, even if a network 

come on. The 

Once you establish the LoomDirect connection you won’t have to go 
through this process again. You can shut down your loom and you’ll 

automatically. 

If you switch to a new device, you will need to connect to LoomDirect on the 
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, or the name of the 

If the loom name is entered, and a USB cable is connected to the loom and 
e loom will default to using the USB cable, even if a network 

The 

e to go 
through this process again. You can shut down your loom and you’ll 

automatically.  

on the 
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Setting
For this connection, you will 
router allows you to access the internet wirelessly on your device. 
computer and the loom will be 
use this connection type, you must have access to the internet.

If you don’t have internet, you can still connect via WiFi with LoomDirect 
connection covered in 

1) 

2) 

3) 

4) 

5) 

Note: 
The network light should remain RED during these steps
Compu
the Compu
router and re
router, make sure that the router is working correctly.
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Setting up Network settings to connect 
For this connection, you will 
router allows you to access the internet wirelessly on your device. 
computer and the loom will be 
use this connection type, you must have access to the internet.

If you don’t have internet, you can still connect via WiFi with LoomDirect 
connection covered in 

 Connect your device to the loom vi

 Go to Network tab in 

 Select your 
for your router. 

 Click the

 Unplug 
go off, indicating
the Network light will change. Wait for the network light to be solid 
red again before continuing.

The network light should remain RED during these steps
Compu-Dobby is connec
the Compu-Dobby has started LoomDirect
router and re-enter the password
router, make sure that the router is working correctly.
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up Network settings to connect 
For this connection, you will 
router allows you to access the internet wirelessly on your device. 
computer and the loom will be 
use this connection type, you must have access to the internet.

If you don’t have internet, you can still connect via WiFi with LoomDirect 
connection covered in its own

Connect your device to the loom vi

Go to Network tab in 

your network from the dropdown list and enter the password 
for your router.  

Click the Restart Network button

Unplug the USB or disconnect from LoomDirect.
go off, indicating 
the Network light will change. Wait for the network light to be solid 
red again before continuing.

The network light should remain RED during these steps
Dobby is connec

Dobby has started LoomDirect
enter the password

router, make sure that the router is working correctly.

 

 

up Network settings to connect 
For this connection, you will connect 
router allows you to access the internet wirelessly on your device. 
computer and the loom will be connected to the same network. 
use this connection type, you must have access to the internet.

If you don’t have internet, you can still connect via WiFi with LoomDirect 
its own section.

Connect your device to the loom vi

Go to Network tab in AVLDrive

network from the dropdown list and enter the password 
 

Restart Network button

or disconnect from LoomDirect.
 that no device is connected.

the Network light will change. Wait for the network light to be solid 
red again before continuing.

The network light should remain RED during these steps
Dobby is connecting to a router

Dobby has started LoomDirect
enter the password.

router, make sure that the router is working correctly.

 

 

up Network settings to connect via
connect using your router 

router allows you to access the internet wirelessly on your device. 
connected to the same network. 

use this connection type, you must have access to the internet.

If you don’t have internet, you can still connect via WiFi with LoomDirect 
section. 

Connect your device to the loom via USB or LoomDirect.

AVLDrive. 

network from the dropdown list and enter the password 

Restart Network button.  

or disconnect from LoomDirect.
that no device is connected.

the Network light will change. Wait for the network light to be solid 
red again before continuing. 

The network light should remain RED during these steps
ting to a router. If your network light 

Dobby has started LoomDirect. Check the password for your 
. If the loom still does not connect to the 

router, make sure that the router is working correctly.

 Compu

 

via router 
your router 

router allows you to access the internet wirelessly on your device. 
connected to the same network. 

use this connection type, you must have access to the internet.

If you don’t have internet, you can still connect via WiFi with LoomDirect 

a USB or LoomDirect.

network from the dropdown list and enter the password 

or disconnect from LoomDirect.
that no device is connected.

the Network light will change. Wait for the network light to be solid 

The network light should remain RED during these steps
. If your network light 

Check the password for your 
If the loom still does not connect to the 

router, make sure that the router is working correctly.
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your router at your location

router allows you to access the internet wirelessly on your device. 
connected to the same network. 

use this connection type, you must have access to the internet. 

If you don’t have internet, you can still connect via WiFi with LoomDirect 

a USB or LoomDirect.

network from the dropdown list and enter the password 

or disconnect from LoomDirect. The COM light will 
that no device is connected. You will also note that 

the Network light will change. Wait for the network light to be solid 

The network light should remain RED during these steps, indicating that the 
. If your network light turns

Check the password for your 
If the loom still does not connect to the 

router, make sure that the router is working correctly. 
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location. The 
router allows you to access the internet wirelessly on your device. Both your 

connected to the same network. In order to 
 

If you don’t have internet, you can still connect via WiFi with LoomDirect 

a USB or LoomDirect. 

network from the dropdown list and enter the password 

The COM light will 
You will also note that 

the Network light will change. Wait for the network light to be solid 

, indicating that the 
turns GREEN, 

Check the password for your 
If the loom still does not connect to the 
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The 
Both your 

In order to 

If you don’t have internet, you can still connect via WiFi with LoomDirect 

 

network from the dropdown list and enter the password 

The COM light will 
You will also note that 

the Network light will change. Wait for the network light to be solid 

, indicating that the 
GREEN, 

If the loom still does not connect to the 
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6) 

7) 

8) 

9) 

10) 

Note:  
If your router name or password changes, you will have to setup the network 
using the USB or LoomDirect

LOST CONNECTION

If the loom loses its connection to the 
follow these steps to reconnect.

1) 

2) 

3) 

4) 

5) 
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 Wait for the WiFi connection to the loom. It can take 
minutes 

 Connect your device (laptop, tablet, phone) to the 
network you connected the loom to. 

 You can refresh your browser. 

 When the devic
COM light indicates only that a device is connected.

 Once you establish
through this process again. You can 
be able to turn the loom on
steps.  

 
If your router name or password changes, you will have to setup the network 
using the USB or LoomDirect

OST CONNECTION

If the loom loses its connection to the 
w these steps to reconnect.

 In the software, go to the Utilities tab.

 Click Shutdown.

 Once the loom has completed the shutdown sequence
have turned off

 Plug the loom back in.

 The loom will perform a normal boot up
router. 
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for the WiFi connection to the loom. It can take 
minutes for the loom to connect to the router.

Connect your device (laptop, tablet, phone) to the 
network you connected the loom to. 

ou can refresh your browser. 

the device is connected
COM light indicates only that a device is connected.

Once you establish
through this process again. You can 
be able to turn the loom on

 

If your router name or password changes, you will have to setup the network 
using the USB or LoomDirect

OST CONNECTION

If the loom loses its connection to the 
w these steps to reconnect.

In the software, go to the Utilities tab.

Click Shutdown. 

Once the loom has completed the shutdown sequence
have turned off, remove power from the loom.

Plug the loom back in.

The loom will perform a normal boot up
 

 

 

for the WiFi connection to the loom. It can take 
for the loom to connect to the router.

Connect your device (laptop, tablet, phone) to the 
network you connected the loom to. 

ou can refresh your browser. 

e is connected
COM light indicates only that a device is connected.

Once you establish the router
through this process again. You can 
be able to turn the loom on

If your router name or password changes, you will have to setup the network 
using the USB or LoomDirect. 

 
If the loom loses its connection to the 

w these steps to reconnect. 

In the software, go to the Utilities tab.

 

Once the loom has completed the shutdown sequence
, remove power from the loom.

Plug the loom back in. 

The loom will perform a normal boot up

 

 

for the WiFi connection to the loom. It can take 
for the loom to connect to the router.

Connect your device (laptop, tablet, phone) to the 
network you connected the loom to. 

ou can refresh your browser.  

e is connected, the COM Light will 
COM light indicates only that a device is connected.

router connection you won’t have to go 
through this process again. You can 
be able to turn the loom on and connect to 

If your router name or password changes, you will have to setup the network 

If the loom loses its connection to the router 

In the software, go to the Utilities tab.

Once the loom has completed the shutdown sequence
, remove power from the loom.

The loom will perform a normal boot up

 

 

for the WiFi connection to the loom. It can take 
for the loom to connect to the router.

Connect your device (laptop, tablet, phone) to the 
network you connected the loom to.  

 

COM Light will 
COM light indicates only that a device is connected.

connection you won’t have to go 
through this process again. You can shutdown your loom and you’ll 

and connect to AVLDrive

If your router name or password changes, you will have to setup the network 

 while in standby power mode, 

In the software, go to the Utilities tab. 

Once the loom has completed the shutdown sequence
, remove power from the loom.

The loom will perform a normal boot up and then reconnect to the 

 Connecting to the Loom

 

for the WiFi connection to the loom. It can take up to several 
for the loom to connect to the router. 

Connect your device (laptop, tablet, phone) to the same 

 

COM Light will come on
COM light indicates only that a device is connected. 

connection you won’t have to go 
hutdown your loom and you’ll 

AVLDrive without these 

If your router name or password changes, you will have to setup the network 

while in standby power mode, 

Once the loom has completed the shutdown sequence and the LEDs 
, remove power from the loom. 

and then reconnect to the 
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up to several 

same WiFi 

come on. The 

connection you won’t have to go 
hutdown your loom and you’ll 

without these 

If your router name or password changes, you will have to setup the network 

while in standby power mode, 

and the LEDs 

and then reconnect to the 
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up to several 

The 

hutdown your loom and you’ll 
without these 

If your router name or password changes, you will have to setup the network 

while in standby power mode, 

and the LEDs 

and then reconnect to the 
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NAMING 

Install Bonjour Print Services for Windows
If you have a Windows computer, you will have to install Bonjour Print 
Services in order to use a loom name. This software is a default part of a 
Mac computer. T
Android device or you prefer not to install the software on your Windows 
computer, you can continue to use the IP address to access AVLDrive.

Bonjour Print Services for Windows lets you access 
browser using your "loom name" as the URL. Example: http://[loom 
name].local. 
computer. 

1) 

2) 

Note: 
Depending on your browser, you will see a notice that th
downloaded at either the top or bottom of the screen. Once the download is 
complete, you may be able to click on the notification to open and install the 
software.
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Install Bonjour Print Services for Windows
If you have a Windows computer, you will have to install Bonjour Print 
Services in order to use a loom name. This software is a default part of a 
Mac computer. T
Android device or you prefer not to install the software on your Windows 
computer, you can continue to use the IP address to access AVLDrive.

Bonjour Print Services for Windows lets you access 
browser using your "loom name" as the URL. Example: http://[loom 
name].local. This service needs to be downloaded and installed on your 
computer.  

 Go to https://suppo

 Click the Download button.
on your computer. For Windows computers, this will most often be 
the Download folder.

Depending on your browser, you will see a notice that th
downloaded at either the top or bottom of the screen. Once the download is 
complete, you may be able to click on the notification to open and install the 
software. 
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OUR LOOM

Install Bonjour Print Services for Windows
If you have a Windows computer, you will have to install Bonjour Print 
Services in order to use a loom name. This software is a default part of a 
Mac computer. There is no similar software for Android. If are using an 
Android device or you prefer not to install the software on your Windows 
computer, you can continue to use the IP address to access AVLDrive.

Bonjour Print Services for Windows lets you access 
browser using your "loom name" as the URL. Example: http://[loom 

This service needs to be downloaded and installed on your 

https://suppo

Click the Download button.
on your computer. For Windows computers, this will most often be 
the Download folder.

Depending on your browser, you will see a notice that th
downloaded at either the top or bottom of the screen. Once the download is 
complete, you may be able to click on the notification to open and install the 

  

 

 

OOM 
Install Bonjour Print Services for Windows
If you have a Windows computer, you will have to install Bonjour Print 
Services in order to use a loom name. This software is a default part of a 

here is no similar software for Android. If are using an 
Android device or you prefer not to install the software on your Windows 
computer, you can continue to use the IP address to access AVLDrive.

Bonjour Print Services for Windows lets you access 
browser using your "loom name" as the URL. Example: http://[loom 

This service needs to be downloaded and installed on your 

https://support.apple.com/kb/DL999?locale=en_US

Click the Download button.
on your computer. For Windows computers, this will most often be 
the Download folder. 

Depending on your browser, you will see a notice that th
downloaded at either the top or bottom of the screen. Once the download is 
complete, you may be able to click on the notification to open and install the 

 

 

Install Bonjour Print Services for Windows
If you have a Windows computer, you will have to install Bonjour Print 
Services in order to use a loom name. This software is a default part of a 

here is no similar software for Android. If are using an 
Android device or you prefer not to install the software on your Windows 
computer, you can continue to use the IP address to access AVLDrive.

Bonjour Print Services for Windows lets you access 
browser using your "loom name" as the URL. Example: http://[loom 

This service needs to be downloaded and installed on your 

rt.apple.com/kb/DL999?locale=en_US

Click the Download button. The file will be downloaded to a location 
on your computer. For Windows computers, this will most often be 

Depending on your browser, you will see a notice that th
downloaded at either the top or bottom of the screen. Once the download is 
complete, you may be able to click on the notification to open and install the 

 Compu

 

Install Bonjour Print Services for Windows 
If you have a Windows computer, you will have to install Bonjour Print 
Services in order to use a loom name. This software is a default part of a 

here is no similar software for Android. If are using an 
Android device or you prefer not to install the software on your Windows 
computer, you can continue to use the IP address to access AVLDrive.

Bonjour Print Services for Windows lets you access AVLDri
browser using your "loom name" as the URL. Example: http://[loom 

This service needs to be downloaded and installed on your 

rt.apple.com/kb/DL999?locale=en_US

The file will be downloaded to a location 
on your computer. For Windows computers, this will most often be 

Depending on your browser, you will see a notice that th
downloaded at either the top or bottom of the screen. Once the download is 
complete, you may be able to click on the notification to open and install the 
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If you have a Windows computer, you will have to install Bonjour Print 
Services in order to use a loom name. This software is a default part of a 

here is no similar software for Android. If are using an 
Android device or you prefer not to install the software on your Windows 
computer, you can continue to use the IP address to access AVLDrive.

AVLDrive via your web 
browser using your "loom name" as the URL. Example: http://[loom 

This service needs to be downloaded and installed on your 

rt.apple.com/kb/DL999?locale=en_US. 

The file will be downloaded to a location 
on your computer. For Windows computers, this will most often be 

Depending on your browser, you will see a notice that the file is being 
downloaded at either the top or bottom of the screen. Once the download is 
complete, you may be able to click on the notification to open and install the 
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Naming Your Loom

If you have a Windows computer, you will have to install Bonjour Print 
Services in order to use a loom name. This software is a default part of a 

here is no similar software for Android. If are using an 
Android device or you prefer not to install the software on your Windows 
computer, you can continue to use the IP address to access AVLDrive. 

via your web 
browser using your "loom name" as the URL. Example: http://[loom 

This service needs to be downloaded and installed on your 

 

The file will be downloaded to a location 
on your computer. For Windows computers, this will most often be 

e file is being 
downloaded at either the top or bottom of the screen. Once the download is 
complete, you may be able to click on the notification to open and install the 
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Services in order to use a loom name. This software is a default part of a 

Android device or you prefer not to install the software on your Windows 

via your web 

The file will be downloaded to a location 
on your computer. For Windows computers, this will most often be 

downloaded at either the top or bottom of the screen. Once the download is 
complete, you may be able to click on the notification to open and install the 
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3) 

4) 

Add Loom Name
Naming your loom is an important step that will make it easy to access your 
loom via WiFi from any device. 

This creates a URL that you type in to the address bar on a web browser. It 
will be easy to remember, unlike the IP
changed at any time.

The LOOM URL 
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 Navigate to the correct folder.

 Open the downloaded file to initiate the

Add Loom Name
Naming your loom is an important step that will make it easy to access your 
loom via WiFi from any device. 

This creates a URL that you type in to the address bar on a web browser. It 
will be easy to remember, unlike the IP
changed at any time.

LOOM URL will be
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Navigate to the correct folder.

Open the downloaded file to initiate the

Add Loom Name 
Naming your loom is an important step that will make it easy to access your 
loom via WiFi from any device. 

This creates a URL that you type in to the address bar on a web browser. It 
will be easy to remember, unlike the IP
changed at any time. 

will be http:// + [loom name] + .local

 

 

Navigate to the correct folder.

Open the downloaded file to initiate the

Naming your loom is an important step that will make it easy to access your 
loom via WiFi from any device.  

This creates a URL that you type in to the address bar on a web browser. It 
will be easy to remember, unlike the IP

http:// + [loom name] + .local

 

 

Navigate to the correct folder. 

Open the downloaded file to initiate the

Naming your loom is an important step that will make it easy to access your 

This creates a URL that you type in to the address bar on a web browser. It 
will be easy to remember, unlike the IP address. Your loom name can be 

http:// + [loom name] + .local

 

 

Open the downloaded file to initiate the install wizard.

Naming your loom is an important step that will make it easy to access your 

This creates a URL that you type in to the address bar on a web browser. It 
address. Your loom name can be 

http:// + [loom name] + .local 

 Connecting to th

 

install wizard. 

 

Naming your loom is an important step that will make it easy to access your 

This creates a URL that you type in to the address bar on a web browser. It 
address. Your loom name can be 
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Naming your loom is an important step that will make it easy to access your 

This creates a URL that you type in to the address bar on a web browser. It 
address. Your loom name can be 

e Loom 
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Naming your loom is an important step that will make it easy to access your 

This creates a URL that you type in to the address bar on a web browser. It 
address. Your loom name can be 
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Example: 

Loom name = myloom

Loom URL = http://myloom.local

Note: 
The name must be a solid piece of text with no spaces. If a space is added to 
the nam
“Loom Name” shows the complete name with the space.

GOOD EXAMPLES: myloom, my_loom, my

BAD EXAMPLES: my loom (loom would only show up as “my”)

Note: 
If you ever forget the name of yo
address

1) 

 

2) 

3) 

4) 
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Example:  

Loom name = myloom

Loom URL = http://myloom.local

The name must be a solid piece of text with no spaces. If a space is added to 
the name, the URL will only be the letters before the space even though the 
“Loom Name” shows the complete name with the space.

GOOD EXAMPLES: myloom, my_loom, my

BAD EXAMPLES: my loom (loom would only show up as “my”)

If you ever forget the name of yo
address. 

 Once you have 

 In the box for Loom Name, enter the name you’d like to use for 
your loom. If the box is not blank, delete the existing name and 
enter the new te

 Click the enter button on your keyboard, or simpl
anywhere on the page.

 Refresh or exit your browser. 
then back on pretty quickly. 
loom name has been changed. Y
field under Please select file has changed.

Connecting to the Loom 

 

Loom name = myloom 

Loom URL = http://myloom.local

The name must be a solid piece of text with no spaces. If a space is added to 
e, the URL will only be the letters before the space even though the 

“Loom Name” shows the complete name with the space.

GOOD EXAMPLES: myloom, my_loom, my

BAD EXAMPLES: my loom (loom would only show up as “my”)

If you ever forget the name of yo

Once you have AVLDrive

In the box for Loom Name, enter the name you’d like to use for 
your loom. If the box is not blank, delete the existing name and 
enter the new text of your choice.

Click the enter button on your keyboard, or simpl
anywhere on the page.

Refresh or exit your browser. 
then back on pretty quickly. 
loom name has been changed. Y
field under Please select file has changed.

 

 

Loom URL = http://myloom.local 

The name must be a solid piece of text with no spaces. If a space is added to 
e, the URL will only be the letters before the space even though the 

“Loom Name” shows the complete name with the space.

GOOD EXAMPLES: myloom, my_loom, my

BAD EXAMPLES: my loom (loom would only show up as “my”)

If you ever forget the name of your loom you can always connect with the IP 

AVLDrive open, select the “Options” tab. 

In the box for Loom Name, enter the name you’d like to use for 
your loom. If the box is not blank, delete the existing name and 

xt of your choice.

Click the enter button on your keyboard, or simpl
anywhere on the page.  

Refresh or exit your browser. 
then back on pretty quickly. 
loom name has been changed. Y
field under Please select file has changed.

 

 

The name must be a solid piece of text with no spaces. If a space is added to 
e, the URL will only be the letters before the space even though the 

“Loom Name” shows the complete name with the space.

GOOD EXAMPLES: myloom, my_loom, my-loom

BAD EXAMPLES: my loom (loom would only show up as “my”)

ur loom you can always connect with the IP 

open, select the “Options” tab. 

In the box for Loom Name, enter the name you’d like to use for 
your loom. If the box is not blank, delete the existing name and 

xt of your choice. 

Click the enter button on your keyboard, or simpl

Refresh or exit your browser. The COM light will turn off and 
then back on pretty quickly. In the Options Tab you’ll see the 
loom name has been changed. You will also see the Connected To: 
field under Please select file has changed.

 Compu

 

The name must be a solid piece of text with no spaces. If a space is added to 
e, the URL will only be the letters before the space even though the 

“Loom Name” shows the complete name with the space.

loom 

BAD EXAMPLES: my loom (loom would only show up as “my”)

ur loom you can always connect with the IP 

open, select the “Options” tab. 

In the box for Loom Name, enter the name you’d like to use for 
your loom. If the box is not blank, delete the existing name and 

Click the enter button on your keyboard, or simpl

The COM light will turn off and 
In the Options Tab you’ll see the 
ou will also see the Connected To: 

field under Please select file has changed. 
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The name must be a solid piece of text with no spaces. If a space is added to 
e, the URL will only be the letters before the space even though the 

“Loom Name” shows the complete name with the space. 

BAD EXAMPLES: my loom (loom would only show up as “my”) 

ur loom you can always connect with the IP 

open, select the “Options” tab. 

In the box for Loom Name, enter the name you’d like to use for 
your loom. If the box is not blank, delete the existing name and 

Click the enter button on your keyboard, or simply clicking 

The COM light will turn off and 
In the Options Tab you’ll see the 
ou will also see the Connected To: 
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Naming Your Loom

The name must be a solid piece of text with no spaces. If a space is added to 
e, the URL will only be the letters before the space even though the 

ur loom you can always connect with the IP 

open, select the “Options” tab.  

In the box for Loom Name, enter the name you’d like to use for 
your loom. If the box is not blank, delete the existing name and 

y clicking 

The COM light will turn off and 
In the Options Tab you’ll see the 
ou will also see the Connected To: 
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The name must be a solid piece of text with no spaces. If a space is added to 
e, the URL will only be the letters before the space even though the 

ur loom you can always connect with the IP 

 

In the box for Loom Name, enter the name you’d like to use for 
your loom. If the box is not blank, delete the existing name and 

The COM light will turn off and 
In the Options Tab you’ll see the 
ou will also see the Connected To: 
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5) 

6) 

7) 

LOSS OF 

If the loom and the software does not seem to be communicating corr
reload the AVLDrive page.

8) 

RESET 

Normally when using a computer, the connection between the computer and 
the loom wi
need to be done manually.
computer.

REBOOT THE 

1) 

SHUTDOWN THE LOOM

If you will be removing the loom from a power source, you 
shutdown the loom using the commands in the software first. This is similar 
to shutting down a computer so that it restarts correctly.

1) 
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Loss of Communication

 Type the new URL into your browser with your new Loom Name as 
shown in the beginning of this section
.local  

 Click Enter on the keyboard

 AVLDrive
communication is established with the loom. You can now use this 
URL to access 

OSS OF COMMUNICATION

If the loom and the software does not seem to be communicating corr
reload the AVLDrive page.

 Reload the AVLDrive page by pressing Ctrl+R(Windows) or 
Cmd+R(Mac). You can also click the reload icon on your browser.

ESET CONNECTION

Normally when using a computer, the connection between the computer and 
the loom will be automatically terminated. When using a tablet, this may 
need to be done manually.
computer. See page 

EBOOT THE 

 Enter “/reboot” after the URL or IP address in your web bro
The loom should reboot

HUTDOWN THE LOOM

will be removing the loom from a power source, you 
shutdown the loom using the commands in the software first. This is similar 
to shutting down a computer so that it restarts correctly.

 In the software, go to the 
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Loss of Communication 

Type the new URL into your browser with your new Loom Name as 
shown in the beginning of this section

Click Enter on the keyboard

AVLDrive will refresh and the COM Light will light up once 
communication is established with the loom. You can now use this 
URL to access AVLDrive

OMMUNICATION

If the loom and the software does not seem to be communicating corr
reload the AVLDrive page.

Reload the AVLDrive page by pressing Ctrl+R(Windows) or 
Cmd+R(Mac). You can also click the reload icon on your browser.

ONNECTION

Normally when using a computer, the connection between the computer and 
ll be automatically terminated. When using a tablet, this may 

need to be done manually.
See page 63 for 

EBOOT THE LOOM

Enter “/reboot” after the URL or IP address in your web bro
The loom should reboot

HUTDOWN THE LOOM

will be removing the loom from a power source, you 
shutdown the loom using the commands in the software first. This is similar 
to shutting down a computer so that it restarts correctly.

In the software, go to the 

 

 

Type the new URL into your browser with your new Loom Name as 
shown in the beginning of this section

Click Enter on the keyboard

refresh and the COM Light will light up once 
communication is established with the loom. You can now use this 

AVLDrive via USB, 

OMMUNICATION

If the loom and the software does not seem to be communicating corr
reload the AVLDrive page. 

Reload the AVLDrive page by pressing Ctrl+R(Windows) or 
Cmd+R(Mac). You can also click the reload icon on your browser.

ONNECTION 
Normally when using a computer, the connection between the computer and 

ll be automatically terminated. When using a tablet, this may 
need to be done manually. Rarely, this may also need to be done on a 

for instructions

OOM 
Enter “/reboot” after the URL or IP address in your web bro
The loom should reboot as if it had been shutdown and restarted.

HUTDOWN THE LOOM 
will be removing the loom from a power source, you 

shutdown the loom using the commands in the software first. This is similar 
to shutting down a computer so that it restarts correctly.

In the software, go to the Utilities

 

 

Type the new URL into your browser with your new Loom Name as 
shown in the beginning of this section

Click Enter on the keyboard. 

refresh and the COM Light will light up once 
communication is established with the loom. You can now use this 

via USB, router

OMMUNICATION 
If the loom and the software does not seem to be communicating corr

Reload the AVLDrive page by pressing Ctrl+R(Windows) or 
Cmd+R(Mac). You can also click the reload icon on your browser.

Normally when using a computer, the connection between the computer and 
ll be automatically terminated. When using a tablet, this may 

Rarely, this may also need to be done on a 
instructions on how to reset the connection.

Enter “/reboot” after the URL or IP address in your web bro
as if it had been shutdown and restarted.

will be removing the loom from a power source, you 
shutdown the loom using the commands in the software first. This is similar 
to shutting down a computer so that it restarts correctly.

Utilities tab.

 

 

Type the new URL into your browser with your new Loom Name as 
shown in the beginning of this section: http://

refresh and the COM Light will light up once 
communication is established with the loom. You can now use this 

router, and LoomDirect. 

If the loom and the software does not seem to be communicating corr

Reload the AVLDrive page by pressing Ctrl+R(Windows) or 
Cmd+R(Mac). You can also click the reload icon on your browser.

Normally when using a computer, the connection between the computer and 
ll be automatically terminated. When using a tablet, this may 

Rarely, this may also need to be done on a 
on how to reset the connection.

Enter “/reboot” after the URL or IP address in your web bro
as if it had been shutdown and restarted.

will be removing the loom from a power source, you 
shutdown the loom using the commands in the software first. This is similar 
to shutting down a computer so that it restarts correctly.

tab. 
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Type the new URL into your browser with your new Loom Name as 
http:// + [loom name] + 

refresh and the COM Light will light up once 
communication is established with the loom. You can now use this 

, and LoomDirect. 

If the loom and the software does not seem to be communicating corr

Reload the AVLDrive page by pressing Ctrl+R(Windows) or 
Cmd+R(Mac). You can also click the reload icon on your browser.

Normally when using a computer, the connection between the computer and 
ll be automatically terminated. When using a tablet, this may 

Rarely, this may also need to be done on a 
on how to reset the connection.

Enter “/reboot” after the URL or IP address in your web bro
as if it had been shutdown and restarted.

will be removing the loom from a power source, you should
shutdown the loom using the commands in the software first. This is similar 
to shutting down a computer so that it restarts correctly. 
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Type the new URL into your browser with your new Loom Name as 
+ [loom name] + 

refresh and the COM Light will light up once 
communication is established with the loom. You can now use this 

, and LoomDirect.  

If the loom and the software does not seem to be communicating correctly, 

Reload the AVLDrive page by pressing Ctrl+R(Windows) or 
Cmd+R(Mac). You can also click the reload icon on your browser.

 

Normally when using a computer, the connection between the computer and 
ll be automatically terminated. When using a tablet, this may 

Rarely, this may also need to be done on a 
on how to reset the connection. 

Enter “/reboot” after the URL or IP address in your web browser. 
as if it had been shutdown and restarted.

should to 
shutdown the loom using the commands in the software first. This is similar 
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Type the new URL into your browser with your new Loom Name as 
+ [loom name] + 

communication is established with the loom. You can now use this 

ectly, 

Cmd+R(Mac). You can also click the reload icon on your browser. 

Normally when using a computer, the connection between the computer and 
ll be automatically terminated. When using a tablet, this may 

wser. 
as if it had been shutdown and restarted. 

shutdown the loom using the commands in the software first. This is similar 
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2) 

3) 

USING 

Weavepoint 8.0.2.0 and above offers direct access to 
with Compu
software, and upload the pattern you have open in Weavepoint. 

AVLDrive only works with WIF files. When a file is opened in AVLDrive using 
WeavePoint, the file has been exported from WeavePoint as a WIF and 
imported to AVLDrive. The WIF file will then be ava
AVLDrive for future use. 

Set Weave Options in WeavePoint

1) 

2) 

Note: 
Choosing 
open. If this is selected, there will be no other options you can choose in 
Weave Options window.
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 Click Shutdown.

 Once the loom has completed the shutdown sequence, you can 
remove power from the loom.

SING WEAVEPOINT

Weavepoint 8.0.2.0 and above offers direct access to 
with Compu-Dobby 

ftware, and upload the pattern you have open in Weavepoint. 

AVLDrive only works with WIF files. When a file is opened in AVLDrive using 
WeavePoint, the file has been exported from WeavePoint as a WIF and 
imported to AVLDrive. The WIF file will then be ava
AVLDrive for future use. 

Set Weave Options in WeavePoint

 Select Options on the Weave menu to open the Weave Options 
dialogue box. 

 Select Compu

Choosing Compu
open. If this is selected, there will be no other options you can choose in 
Weave Options window.

Connecting to the Loom 

 

Click Shutdown. 

Once the loom has completed the shutdown sequence, you can 
remove power from the loom.

EAVEPOINT

Weavepoint 8.0.2.0 and above offers direct access to 
Dobby 5. The loom control function in Weavepoint will open the 

ftware, and upload the pattern you have open in Weavepoint. 

AVLDrive only works with WIF files. When a file is opened in AVLDrive using 
WeavePoint, the file has been exported from WeavePoint as a WIF and 
imported to AVLDrive. The WIF file will then be ava
AVLDrive for future use.  

Set Weave Options in WeavePoint

Select Options on the Weave menu to open the Weave Options 
dialogue box.  

Select Compu-Dobby 

Compu-Dobby 
open. If this is selected, there will be no other options you can choose in 
Weave Options window.

 

 

 

Once the loom has completed the shutdown sequence, you can 
remove power from the loom.

EAVEPOINT 
Weavepoint 8.0.2.0 and above offers direct access to 

. The loom control function in Weavepoint will open the 
ftware, and upload the pattern you have open in Weavepoint. 

AVLDrive only works with WIF files. When a file is opened in AVLDrive using 
WeavePoint, the file has been exported from WeavePoint as a WIF and 
imported to AVLDrive. The WIF file will then be ava

 

Set Weave Options in WeavePoint

Select Options on the Weave menu to open the Weave Options 

Dobby 5.   

Dobby 5 will launch 
open. If this is selected, there will be no other options you can choose in 
Weave Options window. 

 

 

Once the loom has completed the shutdown sequence, you can 
remove power from the loom. 

Weavepoint 8.0.2.0 and above offers direct access to 
. The loom control function in Weavepoint will open the 

ftware, and upload the pattern you have open in Weavepoint. 

AVLDrive only works with WIF files. When a file is opened in AVLDrive using 
WeavePoint, the file has been exported from WeavePoint as a WIF and 
imported to AVLDrive. The WIF file will then be ava

Set Weave Options in WeavePoint 

Select Options on the Weave menu to open the Weave Options 

will launch AVLDrive 
open. If this is selected, there will be no other options you can choose in 

 Compu

 

Once the loom has completed the shutdown sequence, you can 

Weavepoint 8.0.2.0 and above offers direct access to AVLDrive
. The loom control function in Weavepoint will open the 

ftware, and upload the pattern you have open in Weavepoint. 

AVLDrive only works with WIF files. When a file is opened in AVLDrive using 
WeavePoint, the file has been exported from WeavePoint as a WIF and 
imported to AVLDrive. The WIF file will then be available on the File tab in 

Select Options on the Weave menu to open the Weave Options 

AVLDrive with the pattern you 
open. If this is selected, there will be no other options you can choose in 

Compu-Dobby 5 User’s Manual

 Using Weavepoint

Once the loom has completed the shutdown sequence, you can 

AVLDrive 
. The loom control function in Weavepoint will open the 

ftware, and upload the pattern you have open in Weavepoint. 

AVLDrive only works with WIF files. When a file is opened in AVLDrive using 
WeavePoint, the file has been exported from WeavePoint as a WIF and 

ilable on the File tab in 

Select Options on the Weave menu to open the Weave Options 

 

with the pattern you 
open. If this is selected, there will be no other options you can choose in 
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Using Weavepoint

Once the loom has completed the shutdown sequence, you can 

for your loom 
. The loom control function in Weavepoint will open the 

ftware, and upload the pattern you have open in Weavepoint.  

AVLDrive only works with WIF files. When a file is opened in AVLDrive using 
WeavePoint, the file has been exported from WeavePoint as a WIF and 

ilable on the File tab in 

Select Options on the Weave menu to open the Weave Options 

with the pattern you have 
open. If this is selected, there will be no other options you can choose in 
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Using Weavepoint 

for your loom 
. The loom control function in Weavepoint will open the 

AVLDrive only works with WIF files. When a file is opened in AVLDrive using 

ilable on the File tab in 

have 
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Connect to Loom

1) 

2) 

3) 

4) 

Note:  
You may use either the IP Address or the L

5) 

6) 

7) 

8) 

Dobby 5 User’s Manua

Using Weavepoint 

Connect to Loom

 Have the pattern you want to weave with open. You can use 
WeavePoint files or WIF files.

 Select Loom Control on the Weave menu.

 Select USB if your loom is connected with a USB cable. If you are 
connecting to your loom

 If WiFi is chosen, you must enter the Loom Address so that the 
connection will be made correctly.

 
You may use either the IP Address or the L

 If you have a pattern open in WeavePoint, the pattern name will 
display here.

 Select Replace any existing pattern with same name 
overwrite a pattern already on the loom 

 If Start loom contro
open in the loom control so that it is ready for you to weave with.

 Click OK. A message that the pattern was uploaded will appear.

Dobby 5 User’s Manual 

 

Connect to Loom 

Have the pattern you want to weave with open. You can use 
WeavePoint files or WIF files.

Select Loom Control on the Weave menu.

USB if your loom is connected with a USB cable. If you are 
connecting to your loom

If WiFi is chosen, you must enter the Loom Address so that the 
connection will be made correctly.

You may use either the IP Address or the L

If you have a pattern open in WeavePoint, the pattern name will 
display here. 

Replace any existing pattern with same name 
overwrite a pattern already on the loom 

Start loom contro
open in the loom control so that it is ready for you to weave with.

Click OK. A message that the pattern was uploaded will appear.

 

 

Have the pattern you want to weave with open. You can use 
WeavePoint files or WIF files.

Select Loom Control on the Weave menu.

USB if your loom is connected with a USB cable. If you are 
connecting to your loom wirelessly, choose WiFi.

If WiFi is chosen, you must enter the Loom Address so that the 
connection will be made correctly.

You may use either the IP Address or the L

If you have a pattern open in WeavePoint, the pattern name will 

Replace any existing pattern with same name 
overwrite a pattern already on the loom 

Start loom control with this pattern 
open in the loom control so that it is ready for you to weave with.

Click OK. A message that the pattern was uploaded will appear.

 

 

Have the pattern you want to weave with open. You can use 
WeavePoint files or WIF files. 

Select Loom Control on the Weave menu.

USB if your loom is connected with a USB cable. If you are 
wirelessly, choose WiFi.

If WiFi is chosen, you must enter the Loom Address so that the 
connection will be made correctly. 

You may use either the IP Address or the Loom Name for the Compu

If you have a pattern open in WeavePoint, the pattern name will 

Replace any existing pattern with same name 
overwrite a pattern already on the loom 

l with this pattern 
open in the loom control so that it is ready for you to weave with.

Click OK. A message that the pattern was uploaded will appear.

 

 

Have the pattern you want to weave with open. You can use 

Select Loom Control on the Weave menu. 

USB if your loom is connected with a USB cable. If you are 
wirelessly, choose WiFi.

If WiFi is chosen, you must enter the Loom Address so that the 

oom Name for the Compu

If you have a pattern open in WeavePoint, the pattern name will 

Replace any existing pattern with same name 
overwrite a pattern already on the loom with 

l with this pattern is checked, the pattern will 
open in the loom control so that it is ready for you to weave with.

Click OK. A message that the pattern was uploaded will appear.

 Connecting to the Loom

 

Have the pattern you want to weave with open. You can use 

 

USB if your loom is connected with a USB cable. If you are 
wirelessly, choose WiFi. 

If WiFi is chosen, you must enter the Loom Address so that the 

oom Name for the Compu

If you have a pattern open in WeavePoint, the pattern name will 

Replace any existing pattern with same name if you want to 
 the same name.

is checked, the pattern will 
open in the loom control so that it is ready for you to weave with.

Click OK. A message that the pattern was uploaded will appear.

Connecting to the Loom

 Page | 

Have the pattern you want to weave with open. You can use 

USB if your loom is connected with a USB cable. If you are 

If WiFi is chosen, you must enter the Loom Address so that the 

oom Name for the Compu-Dobby 

If you have a pattern open in WeavePoint, the pattern name will 

if you want to 
the same name. 

is checked, the pattern will 
open in the loom control so that it is ready for you to weave with.

Click OK. A message that the pattern was uploaded will appear. 
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USB if your loom is connected with a USB cable. If you are 

Dobby 5. 

If you have a pattern open in WeavePoint, the pattern name will 

if you want to 

is checked, the pattern will 
open in the loom control so that it is ready for you to weave with. 
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9) 

Connecting to the Loom

22 

 Click OK. The pattern will open in 

Connecting to the Loom 

 

Click OK. The pattern will open in 

 

 

Click OK. The pattern will open in 

 

 

Click OK. The pattern will open in AVLDrive

 Compu

 

 

AVLDrive in the Weaving tab.
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 Using Weavepoint

in the Weaving tab.
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Using Weavepoint

in the Weaving tab. 
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Using Weavepoint 
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WEAVING WITH 
THE COMPU-

DOBBY 5 
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No matter how you are connecting to the loom, the loom software will 
appear in your browser. Depending on the browser you are using, the 
software may appear subtly different from the pictures in this manual, 
however all functionali

When you power on the loom using the software, the loom will go through a 
series of self
initialization, and (if the loom has two warp beams) the second warp tension 
motor initializ
know that the tension system is calibrating. It will be removed when the 
calibration is complete
take about 90 seconds. If you have two, it 
the self

The software allows you to make changes to the loom as you weave, 
including the pick to be woven. If the shed is closed, the changes will be 
made immediately as the button is pressed in the software. If the shed is 
not closed, the changes will be reflected in the Next field and will be made 
when the shed is returned to the closed state.

WARPING THE 

Looms with automatic warp tension motors are d
wind on the warp without removing the tension cable. A 
Weaving tab

1) 

2) 

Note: 
If you open a file for weaving (see page 
loom will automatically power on.

3) 

4) 
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No matter how you are connecting to the loom, the loom software will 
appear in your browser. Depending on the browser you are using, the 
software may appear subtly different from the pictures in this manual, 
however all functionali

When you power on the loom using the software, the loom will go through a 
series of self-tests: The solenoid self
initialization, and (if the loom has two warp beams) the second warp tension 
motor initialization. 
know that the tension system is calibrating. It will be removed when the 
calibration is complete
take about 90 seconds. If you have two, it 
the self-tests are complete, you will be able to continue using the software.

The software allows you to make changes to the loom as you weave, 
including the pick to be woven. If the shed is closed, the changes will be 

immediately as the button is pressed in the software. If the shed is 
not closed, the changes will be reflected in the Next field and will be made 
when the shed is returned to the closed state.

ARPING THE 

Looms with automatic warp tension motors are d
wind on the warp without removing the tension cable. A 
Weaving tab allow

 Connect to the loom as described previous
to the File tab.

 Open the Wea
open. 

If you open a file for weaving (see page 
loom will automatically power on.

 Click Power On to boot up the loom. 

 The loom will
switch to 
briefly yellow, then 
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No matter how you are connecting to the loom, the loom software will 
appear in your browser. Depending on the browser you are using, the 
software may appear subtly different from the pictures in this manual, 
however all functionality will be the same.

When you power on the loom using the software, the loom will go through a 
tests: The solenoid self

initialization, and (if the loom has two warp beams) the second warp tension 
ation. A notification will appear in the software letting you 

know that the tension system is calibrating. It will be removed when the 
calibration is complete. If you have one warp tension motor, the process will 
take about 90 seconds. If you have two, it 

tests are complete, you will be able to continue using the software.

The software allows you to make changes to the loom as you weave, 
including the pick to be woven. If the shed is closed, the changes will be 

immediately as the button is pressed in the software. If the shed is 
not closed, the changes will be reflected in the Next field and will be made 
when the shed is returned to the closed state.

ARPING THE LOOM

Looms with automatic warp tension motors are d
wind on the warp without removing the tension cable. A 

allows you to set the tension to the lowest setting. 

Connect to the loom as described previous
to the File tab. 

Open the Weaving tab

If you open a file for weaving (see page 
loom will automatically power on.

Click Power On to boot up the loom. 

The loom will begin its self
switch to Power Off
briefly yellow, then 

Dobby 5 

 

No matter how you are connecting to the loom, the loom software will 
appear in your browser. Depending on the browser you are using, the 
software may appear subtly different from the pictures in this manual, 

ty will be the same.

When you power on the loom using the software, the loom will go through a 
tests: The solenoid self

initialization, and (if the loom has two warp beams) the second warp tension 
A notification will appear in the software letting you 

know that the tension system is calibrating. It will be removed when the 
. If you have one warp tension motor, the process will 

take about 90 seconds. If you have two, it 
tests are complete, you will be able to continue using the software.

The software allows you to make changes to the loom as you weave, 
including the pick to be woven. If the shed is closed, the changes will be 

immediately as the button is pressed in the software. If the shed is 
not closed, the changes will be reflected in the Next field and will be made 
when the shed is returned to the closed state.

OOM 
Looms with automatic warp tension motors are d
wind on the warp without removing the tension cable. A 

you to set the tension to the lowest setting. 

Connect to the loom as described previous

ving tab. You do not need to have a weaving file 

If you open a file for weaving (see page 
loom will automatically power on. 

Click Power On to boot up the loom. 

begin its self
Power Off and the Power light on the interface 

briefly yellow, then red.  

 

 

No matter how you are connecting to the loom, the loom software will 
appear in your browser. Depending on the browser you are using, the 
software may appear subtly different from the pictures in this manual, 

ty will be the same. 

When you power on the loom using the software, the loom will go through a 
tests: The solenoid self-test, the warp tension motor 

initialization, and (if the loom has two warp beams) the second warp tension 
A notification will appear in the software letting you 

know that the tension system is calibrating. It will be removed when the 
. If you have one warp tension motor, the process will 

take about 90 seconds. If you have two, it will be about 180 seconds. Once 
tests are complete, you will be able to continue using the software.

The software allows you to make changes to the loom as you weave, 
including the pick to be woven. If the shed is closed, the changes will be 

immediately as the button is pressed in the software. If the shed is 
not closed, the changes will be reflected in the Next field and will be made 
when the shed is returned to the closed state.

Looms with automatic warp tension motors are d
wind on the warp without removing the tension cable. A 

you to set the tension to the lowest setting. 

Connect to the loom as described previous

You do not need to have a weaving file 

If you open a file for weaving (see page 26) when the loom is powered off, the 
 

Click Power On to boot up the loom. 

begin its self-tests. At the same time, th
and the Power light on the interface 

 Compu

 

No matter how you are connecting to the loom, the loom software will 
appear in your browser. Depending on the browser you are using, the 
software may appear subtly different from the pictures in this manual, 

When you power on the loom using the software, the loom will go through a 
test, the warp tension motor 

initialization, and (if the loom has two warp beams) the second warp tension 
A notification will appear in the software letting you 

know that the tension system is calibrating. It will be removed when the 
. If you have one warp tension motor, the process will 

will be about 180 seconds. Once 
tests are complete, you will be able to continue using the software.

The software allows you to make changes to the loom as you weave, 
including the pick to be woven. If the shed is closed, the changes will be 

immediately as the button is pressed in the software. If the shed is 
not closed, the changes will be reflected in the Next field and will be made 
when the shed is returned to the closed state. 

Looms with automatic warp tension motors are designed to allow you to 
wind on the warp without removing the tension cable. A 

you to set the tension to the lowest setting. 

Connect to the loom as described previously. 

You do not need to have a weaving file 

) when the loom is powered off, the 

Click Power On to boot up the loom.  

 

tests. At the same time, th
and the Power light on the interface 
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 Warping the Lo

No matter how you are connecting to the loom, the loom software will 
appear in your browser. Depending on the browser you are using, the 
software may appear subtly different from the pictures in this manual, 

When you power on the loom using the software, the loom will go through a 
test, the warp tension motor 

initialization, and (if the loom has two warp beams) the second warp tension 
A notification will appear in the software letting you 

know that the tension system is calibrating. It will be removed when the 
. If you have one warp tension motor, the process will 

will be about 180 seconds. Once 
tests are complete, you will be able to continue using the software.

The software allows you to make changes to the loom as you weave, 
including the pick to be woven. If the shed is closed, the changes will be 

immediately as the button is pressed in the software. If the shed is 
not closed, the changes will be reflected in the Next field and will be made 

esigned to allow you to 
wind on the warp without removing the tension cable. A button 

you to set the tension to the lowest setting. 

 The software defaults 

You do not need to have a weaving file 

) when the loom is powered off, the 

 

tests. At the same time, the button will 
and the Power light on the interface 
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Warping the Lo

No matter how you are connecting to the loom, the loom software will 
appear in your browser. Depending on the browser you are using, the 
software may appear subtly different from the pictures in this manual, 

When you power on the loom using the software, the loom will go through a 
test, the warp tension motor 

initialization, and (if the loom has two warp beams) the second warp tension 
A notification will appear in the software letting you 

know that the tension system is calibrating. It will be removed when the 
. If you have one warp tension motor, the process will 

will be about 180 seconds. Once 
tests are complete, you will be able to continue using the software.

The software allows you to make changes to the loom as you weave, 
including the pick to be woven. If the shed is closed, the changes will be 

immediately as the button is pressed in the software. If the shed is 
not closed, the changes will be reflected in the Next field and will be made 

esigned to allow you to 
 on the 

you to set the tension to the lowest setting.  

The software defaults 

You do not need to have a weaving file 

) when the loom is powered off, the 

e button will 
and the Power light on the interface will turn
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Warping the Loom 

When you power on the loom using the software, the loom will go through a 

initialization, and (if the loom has two warp beams) the second warp tension 

know that the tension system is calibrating. It will be removed when the 
. If you have one warp tension motor, the process will 

will be about 180 seconds. Once 
tests are complete, you will be able to continue using the software. 

including the pick to be woven. If the shed is closed, the changes will be 
immediately as the button is pressed in the software. If the shed is 

not closed, the changes will be reflected in the Next field and will be made 

The software defaults 

) when the loom is powered off, the 

e button will 
will turn 
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Warping the Loom

5) 

6) 

7) 

8) 

 

Dobby 5 User’s Manual

Warping the Loom 

 Click the 

 The button will turn red to indicate it is activated. 
again to turn it off.

 Wind the warp onto the warp beam. For more information, see the 
weaving section in your loom manual.

 You can click Power Off to return 
threading the heddles and reed. If you are going to turn off pow
to the loom, shutdown the loom through the software.
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Click the free warp tension button.

The button will turn red to indicate it is activated. 
again to turn it off.

Wind the warp onto the warp beam. For more information, see the 
weaving section in your loom manual.

You can click Power Off to return 
threading the heddles and reed. If you are going to turn off pow
to the loom, shutdown the loom through the software.

  

 

 

warp tension button.

The button will turn red to indicate it is activated. 
again to turn it off. 

Wind the warp onto the warp beam. For more information, see the 
weaving section in your loom manual.

You can click Power Off to return 
threading the heddles and reed. If you are going to turn off pow
to the loom, shutdown the loom through the software.

 

 

warp tension button. 

The button will turn red to indicate it is activated. 

Wind the warp onto the warp beam. For more information, see the 
weaving section in your loom manual.

You can click Power Off to return the loom
threading the heddles and reed. If you are going to turn off pow
to the loom, shutdown the loom through the software.

 Weaving with the Compu

 

 

The button will turn red to indicate it is activated. 

Wind the warp onto the warp beam. For more information, see the 
weaving section in your loom manual. 

the loom to standby when 
threading the heddles and reed. If you are going to turn off pow
to the loom, shutdown the loom through the software.

 

Weaving with the Compu

 

 

 

The button will turn red to indicate it is activated. Click the

 

Wind the warp onto the warp beam. For more information, see the 

to standby when 
threading the heddles and reed. If you are going to turn off pow
to the loom, shutdown the loom through the software. 

Weaving with the Compu-Dobby 5
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Click the button 

Wind the warp onto the warp beam. For more information, see the 

to standby when 
threading the heddles and reed. If you are going to turn off pow
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button 

Wind the warp onto the warp beam. For more information, see the 

threading the heddles and reed. If you are going to turn off power 
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OPEN A FILE FOR 

1) 

2) 

3) 

Note: 
You can also double
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PEN A FILE FOR 

 Connect to the loom as described previously. The software defaults 
to the File tab.
how to import files, see page 

 Click a file from the list to select it.

 Click Open for Weaving. The Weaving tab will open with your 
selected file

You can also double

Weaving with the Compu-Dobby 5

 

PEN A FILE FOR W
Connect to the loom as described previously. The software defaults 
to the File tab. For complete information on the Files tab, including 
how to import files, see page 

Click a file from the list to select it.

Click Open for Weaving. The Weaving tab will open with your 
selected file as shown in the next screenshot

You can also double-click a file to open it for weaving.
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WEAVING

Connect to the loom as described previously. The software defaults 
For complete information on the Files tab, including 

how to import files, see page 

Click a file from the list to select it.

Click Open for Weaving. The Weaving tab will open with your 
as shown in the next screenshot

click a file to open it for weaving.

 

 

EAVING 
Connect to the loom as described previously. The software defaults 

For complete information on the Files tab, including 
how to import files, see page 44. 

Click a file from the list to select it. 

Click Open for Weaving. The Weaving tab will open with your 
as shown in the next screenshot

click a file to open it for weaving.

 Compu

 

Connect to the loom as described previously. The software defaults 
For complete information on the Files tab, including 

 

Click Open for Weaving. The Weaving tab will open with your 
as shown in the next screenshot.

click a file to open it for weaving.
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 Open a file for Weaving

Connect to the loom as described previously. The software defaults 
For complete information on the Files tab, including 

Click Open for Weaving. The Weaving tab will open with your 
. 

click a file to open it for weaving. 
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Open a file for Weaving

Connect to the loom as described previously. The software defaults 
For complete information on the Files tab, including 

Click Open for Weaving. The Weaving tab will open with your 

Dobby 5 User’s Manual 

Open a file for Weaving 

Connect to the loom as described previously. The software defaults 
For complete information on the Files tab, including 
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Open a file for Weaving

Power On
When you power on the loom using the software, the loom will go through a 
series of self
initialization, and (if the loom has two warp beams) the second warp tension 
motor initialization. 
know that the tension system is calibrating. It will be removed when the 
calibration is complete. 
take about 90 seconds. If you have two, it will be about 180 second
the self
The motors 

Note: 
If you open a file for weaving (see page 
loom will automatically power on.

The Power button is used to turn weaving mode on/off. It is not used to 
completely Shutdown the loom. Shutting down the loom is done through the 
utilities tab and is only needed when preparing the loom to be un
form power. 

1) 
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Open a file for Weaving

Power On 
n you power on the loom using the software, the loom will go through a 

series of self-tests: The solenoid self
initialization, and (if the loom has two warp beams) the second warp tension 
motor initialization. 
know that the tension system is calibrating. It will be removed when the 
calibration is complete. 
take about 90 seconds. If you have two, it will be about 180 second
the self-tests are complete, you will be able to continue using the software. 
he motors should return to the

If you open a file for weaving (see page 
loom will automatically power on.

The Power button is used to turn weaving mode on/off. It is not used to 
completely Shutdown the loom. Shutting down the loom is done through the 
utilities tab and is only needed when preparing the loom to be un
form power.  

 Click Power On to boot up the loom. 
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n you power on the loom using the software, the loom will go through a 
tests: The solenoid self

initialization, and (if the loom has two warp beams) the second warp tension 
motor initialization. A notification wi
know that the tension system is calibrating. It will be removed when the 
calibration is complete. If you have one warp tension motor, the process will 
take about 90 seconds. If you have two, it will be about 180 second

tests are complete, you will be able to continue using the software. 
should return to the

If you open a file for weaving (see page 
loom will automatically power on.

The Power button is used to turn weaving mode on/off. It is not used to 
completely Shutdown the loom. Shutting down the loom is done through the 
utilities tab and is only needed when preparing the loom to be un

Click Power On to boot up the loom. 

 

 

n you power on the loom using the software, the loom will go through a 
tests: The solenoid self

initialization, and (if the loom has two warp beams) the second warp tension 
A notification wi

know that the tension system is calibrating. It will be removed when the 
If you have one warp tension motor, the process will 

take about 90 seconds. If you have two, it will be about 180 second
tests are complete, you will be able to continue using the software. 

should return to the setting

If you open a file for weaving (see page 
loom will automatically power on. 

The Power button is used to turn weaving mode on/off. It is not used to 
completely Shutdown the loom. Shutting down the loom is done through the 
utilities tab and is only needed when preparing the loom to be un

Click Power On to boot up the loom. 

 

 

n you power on the loom using the software, the loom will go through a 
tests: The solenoid self-test, the warp tension motor 

initialization, and (if the loom has two warp beams) the second warp tension 
A notification will appear in the software letting you 

know that the tension system is calibrating. It will be removed when the 
If you have one warp tension motor, the process will 

take about 90 seconds. If you have two, it will be about 180 second
tests are complete, you will be able to continue using the software. 

settings the loom was shutdown in. 

If you open a file for weaving (see page 26) when the loom is power
 

The Power button is used to turn weaving mode on/off. It is not used to 
completely Shutdown the loom. Shutting down the loom is done through the 
utilities tab and is only needed when preparing the loom to be un

Click Power On to boot up the loom. 
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n you power on the loom using the software, the loom will go through a 
test, the warp tension motor 

initialization, and (if the loom has two warp beams) the second warp tension 
ll appear in the software letting you 

know that the tension system is calibrating. It will be removed when the 
If you have one warp tension motor, the process will 

take about 90 seconds. If you have two, it will be about 180 second
tests are complete, you will be able to continue using the software. 

the loom was shutdown in. 

) when the loom is power

The Power button is used to turn weaving mode on/off. It is not used to 
completely Shutdown the loom. Shutting down the loom is done through the 
utilities tab and is only needed when preparing the loom to be un

Click Power On to boot up the loom.  
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n you power on the loom using the software, the loom will go through a 
test, the warp tension motor 

initialization, and (if the loom has two warp beams) the second warp tension 
ll appear in the software letting you 

know that the tension system is calibrating. It will be removed when the 
If you have one warp tension motor, the process will 

take about 90 seconds. If you have two, it will be about 180 second
tests are complete, you will be able to continue using the software. 

the loom was shutdown in. 

) when the loom is power

The Power button is used to turn weaving mode on/off. It is not used to 
completely Shutdown the loom. Shutting down the loom is done through the 
utilities tab and is only needed when preparing the loom to be un
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n you power on the loom using the software, the loom will go through a 
test, the warp tension motor 

initialization, and (if the loom has two warp beams) the second warp tension 
ll appear in the software letting you 

know that the tension system is calibrating. It will be removed when the 
If you have one warp tension motor, the process will 

take about 90 seconds. If you have two, it will be about 180 seconds. Once 
tests are complete, you will be able to continue using the software. 

the loom was shutdown in.  

) when the loom is powered off, the 

The Power button is used to turn weaving mode on/off. It is not used to 
completely Shutdown the loom. Shutting down the loom is done through the 
utilities tab and is only needed when preparing the loom to be unplugged 
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n you power on the loom using the software, the loom will go through a 

initialization, and (if the loom has two warp beams) the second warp tension 

know that the tension system is calibrating. It will be removed when the 
If you have one warp tension motor, the process will 

s. Once 
tests are complete, you will be able to continue using the software. 

ed off, the 

completely Shutdown the loom. Shutting down the loom is done through the 
plugged 
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2) 

3) 

RESUME A WEAVING SESS

1) 

2) 
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 The loom will begin its self
switch to 
briefly yellow, then red.

 Once the loom 
commence weaving

ESUME A WEAVING SESS

 Connect to the loom as described previously. The software defaults 
to the File tab.
how to import files, see page 

 Click the file that was last being used to resume the session

e Compu-Dobby 5

 

The loom will begin its self
switch to Power Off
briefly yellow, then red.

Once the loom has complete
commence weaving

ESUME A WEAVING SESS

Connect to the loom as described previously. The software defaults 
to the File tab. For complete information on the Files tab, including 
how to import files, see page 

the file that was last being used to resume the session
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The loom will begin its self
Power Off and the Power light on the interface will turn 

briefly yellow, then red.   

has complete
commence weaving. 

ESUME A WEAVING SESSION

Connect to the loom as described previously. The software defaults 
For complete information on the Files tab, including 

how to import files, see page 

the file that was last being used to resume the session

 

 

The loom will begin its self-tests. At the same time, the button will 
and the Power light on the interface will turn 

has completed its self

ION 
Connect to the loom as described previously. The software defaults 

For complete information on the Files tab, including 
how to import files, see page 44. 

the file that was last being used to resume the session

 Compu

 

tests. At the same time, the button will 
and the Power light on the interface will turn 

d its self-tests, you will be able to 

Connect to the loom as described previously. The software defaults 
For complete information on the Files tab, including 

the file that was last being used to resume the session
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 Resume a weaving session

tests. At the same time, the button will 
and the Power light on the interface will turn 

 

you will be able to 

Connect to the loom as described previously. The software defaults 
For complete information on the Files tab, including 

the file that was last being used to resume the session
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Resume a weaving session

tests. At the same time, the button will 
and the Power light on the interface will turn 

you will be able to 

Connect to the loom as described previously. The software defaults 
For complete information on the Files tab, including 

the file that was last being used to resume the session. 
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Resume a weaving session 

tests. At the same time, the button will 
and the Power light on the interface will turn 

Connect to the loom as described previously. The software defaults 
For complete information on the Files tab, including 
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Controlling the Cloth Advance

3) 

4) 

CONTROLLING THE 

The cloth advance controls allow you to advance
or reverse the warp. You can also set the picks per inch (PPI). The default 
PPI is 15.

Set the PPI
The default for the cloth advance is picks per inch, but you can change 
inches to centimeters in the options tab.
changing to centimeters.

It’s important to note that PPI can be affected by types of yarn and the sett, 
so please use the PPI as indicated in the Cloth Advance Box as a starting 
point, and understand that number
correct PPI on the cloth. However, once you have the PPI set, it will not 
change on the cloth until adjusted in the software.

1) 

2) 

Note: 
If you want to advance the warp quickly, for example when warping the loom, 
set the PPI to one.

Advance the Warp
Typically, you manually advance forward to bring the fell line to the correct 
weaving position
when the beater arms hit the bumpers and the fell line is at the reed.
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 Click Open for Weaving.

 The resume weaving dialog appears. Click OK to continue weaving.

ONTROLLING THE 

The cloth advance controls allow you to advance
or reverse the warp. You can also set the picks per inch (PPI). The default 
PPI is 15. 

Set the PPI 
The default for the cloth advance is picks per inch, but you can change 
inches to centimeters in the options tab.
changing to centimeters.

It’s important to note that PPI can be affected by types of yarn and the sett, 
so please use the PPI as indicated in the Cloth Advance Box as a starting 
point, and understand that number
correct PPI on the cloth. However, once you have the PPI set, it will not 
change on the cloth until adjusted in the software.

 In the software go to the Cloth Advance area and click in the 
field.  

 Use the small 
and type in the value you want.
when typing, for example “15.25”.

If you want to advance the warp quickly, for example when warping the loom, 
set the PPI to one.

vance the Warp
Typically, you manually advance forward to bring the fell line to the correct 
weaving position
when the beater arms hit the bumpers and the fell line is at the reed.
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Controlling the Cloth Advance 

Click Open for Weaving.

The resume weaving dialog appears. Click OK to continue weaving.

ONTROLLING THE 

The cloth advance controls allow you to advance
or reverse the warp. You can also set the picks per inch (PPI). The default 

The default for the cloth advance is picks per inch, but you can change 
inches to centimeters in the options tab.
changing to centimeters. 

It’s important to note that PPI can be affected by types of yarn and the sett, 
so please use the PPI as indicated in the Cloth Advance Box as a starting 
point, and understand that number
correct PPI on the cloth. However, once you have the PPI set, it will not 
change on the cloth until adjusted in the software.

In the software go to the Cloth Advance area and click in the 

Use the small arrow keys to change the value, or click in the field 
and type in the value you want.
when typing, for example “15.25”.

If you want to advance the warp quickly, for example when warping the loom, 
set the PPI to one. 

vance the Warp 
Typically, you manually advance forward to bring the fell line to the correct 
weaving position after you have warped the loom
when the beater arms hit the bumpers and the fell line is at the reed.

 

 

Click Open for Weaving. 

The resume weaving dialog appears. Click OK to continue weaving.

ONTROLLING THE CLOTH 

The cloth advance controls allow you to advance
or reverse the warp. You can also set the picks per inch (PPI). The default 

The default for the cloth advance is picks per inch, but you can change 
inches to centimeters in the options tab.

 

It’s important to note that PPI can be affected by types of yarn and the sett, 
so please use the PPI as indicated in the Cloth Advance Box as a starting 
point, and understand that numbers may need to be adjusted to get the 
correct PPI on the cloth. However, once you have the PPI set, it will not 
change on the cloth until adjusted in the software.

In the software go to the Cloth Advance area and click in the 

arrow keys to change the value, or click in the field 
and type in the value you want.
when typing, for example “15.25”.

If you want to advance the warp quickly, for example when warping the loom, 

Typically, you manually advance forward to bring the fell line to the correct 
after you have warped the loom

when the beater arms hit the bumpers and the fell line is at the reed.

 

 

The resume weaving dialog appears. Click OK to continue weaving.

LOTH ADVANCE

The cloth advance controls allow you to advance
or reverse the warp. You can also set the picks per inch (PPI). The default 

The default for the cloth advance is picks per inch, but you can change 
inches to centimeters in the options tab. See page 

It’s important to note that PPI can be affected by types of yarn and the sett, 
so please use the PPI as indicated in the Cloth Advance Box as a starting 

s may need to be adjusted to get the 
correct PPI on the cloth. However, once you have the PPI set, it will not 
change on the cloth until adjusted in the software.

In the software go to the Cloth Advance area and click in the 

arrow keys to change the value, or click in the field 
and type in the value you want. You can enter fractional values 
when typing, for example “15.25”. 

If you want to advance the warp quickly, for example when warping the loom, 

Typically, you manually advance forward to bring the fell line to the correct 
after you have warped the loom

when the beater arms hit the bumpers and the fell line is at the reed.
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The resume weaving dialog appears. Click OK to continue weaving.

DVANCE 
The cloth advance controls allow you to advance the warp without weaving, 
or reverse the warp. You can also set the picks per inch (PPI). The default 

The default for the cloth advance is picks per inch, but you can change 
See page 52 

It’s important to note that PPI can be affected by types of yarn and the sett, 
so please use the PPI as indicated in the Cloth Advance Box as a starting 

s may need to be adjusted to get the 
correct PPI on the cloth. However, once you have the PPI set, it will not 
change on the cloth until adjusted in the software. 

In the software go to the Cloth Advance area and click in the 

arrow keys to change the value, or click in the field 
You can enter fractional values 

If you want to advance the warp quickly, for example when warping the loom, 

Typically, you manually advance forward to bring the fell line to the correct 
after you have warped the loom. The correct position is 

when the beater arms hit the bumpers and the fell line is at the reed.

Weaving with the Compu

 

The resume weaving dialog appears. Click OK to continue weaving.

the warp without weaving, 
or reverse the warp. You can also set the picks per inch (PPI). The default 

The default for the cloth advance is picks per inch, but you can change 
 for instructions on 

It’s important to note that PPI can be affected by types of yarn and the sett, 
so please use the PPI as indicated in the Cloth Advance Box as a starting 

s may need to be adjusted to get the 
correct PPI on the cloth. However, once you have the PPI set, it will not 

In the software go to the Cloth Advance area and click in the 

 

arrow keys to change the value, or click in the field 
You can enter fractional values 

If you want to advance the warp quickly, for example when warping the loom, 

Typically, you manually advance forward to bring the fell line to the correct 
. The correct position is 

when the beater arms hit the bumpers and the fell line is at the reed.
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The resume weaving dialog appears. Click OK to continue weaving.

the warp without weaving, 
or reverse the warp. You can also set the picks per inch (PPI). The default 

The default for the cloth advance is picks per inch, but you can change 
for instructions on 

It’s important to note that PPI can be affected by types of yarn and the sett, 
so please use the PPI as indicated in the Cloth Advance Box as a starting 

s may need to be adjusted to get the 
correct PPI on the cloth. However, once you have the PPI set, it will not 

In the software go to the Cloth Advance area and click in the PPI 

arrow keys to change the value, or click in the field 
You can enter fractional values 

If you want to advance the warp quickly, for example when warping the loom, 

Typically, you manually advance forward to bring the fell line to the correct 
. The correct position is 

when the beater arms hit the bumpers and the fell line is at the reed. 
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The resume weaving dialog appears. Click OK to continue weaving. 

the warp without weaving, 
or reverse the warp. You can also set the picks per inch (PPI). The default 

It’s important to note that PPI can be affected by types of yarn and the sett, 
so please use the PPI as indicated in the Cloth Advance Box as a starting 

PPI 

arrow keys to change the value, or click in the field 

If you want to advance the warp quickly, for example when warping the loom, 

Typically, you manually advance forward to bring the fell line to the correct 
. The correct position is 
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3) 

4) 

SET W
You can set the tension by entering a number in the field or by using the up 
and down arrows on the 

When the
search for its reference home, then return to the tension setting left by the 
weaver in the previous weaving session.

1) 

 

Weaving with the Compu

30 

 In the software 

 Use the 
warp has advanced as far as you want it.

WARP T
You can set the tension by entering a number in the field or by using the up 
and down arrows on the 

the loom is powered on for weaving, the warp tension motor will 
search for its reference home, then return to the tension setting left by the 
weaver in the previous weaving session.

 In the software go to the 
change the value, or click in the field and type in the value you 
want. 
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In the software go to the Cloth Advance area. 

Use the up arrow to advance the warp. Click the arrow until the 
warp has advanced as far as you want it.

TENSION

You can set the tension by entering a number in the field or by using the up 
and down arrows on the field. The default tension is set at 55.

loom is powered on for weaving, the warp tension motor will 
search for its reference home, then return to the tension setting left by the 
weaver in the previous weaving session.

In the software go to the 
change the value, or click in the field and type in the value you 
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go to the Cloth Advance area. 

arrow to advance the warp. Click the arrow until the 
warp has advanced as far as you want it.

ENSION 
You can set the tension by entering a number in the field or by using the up 

field. The default tension is set at 55.

loom is powered on for weaving, the warp tension motor will 
search for its reference home, then return to the tension setting left by the 
weaver in the previous weaving session.

In the software go to the Warp Tension field
change the value, or click in the field and type in the value you 

 

 

go to the Cloth Advance area. 

arrow to advance the warp. Click the arrow until the 
warp has advanced as far as you want it.

You can set the tension by entering a number in the field or by using the up 
field. The default tension is set at 55.

loom is powered on for weaving, the warp tension motor will 
search for its reference home, then return to the tension setting left by the 
weaver in the previous weaving session. 

Warp Tension field
change the value, or click in the field and type in the value you 

 Compu

 

go to the Cloth Advance area. 

arrow to advance the warp. Click the arrow until the 
warp has advanced as far as you want it. 

You can set the tension by entering a number in the field or by using the up 
field. The default tension is set at 55.

loom is powered on for weaving, the warp tension motor will 
search for its reference home, then return to the tension setting left by the 

Warp Tension field. Use the arrow keys to 
change the value, or click in the field and type in the value you 
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 Set Warp Tension

go to the Cloth Advance area.  

 

arrow to advance the warp. Click the arrow until the 

You can set the tension by entering a number in the field or by using the up 
field. The default tension is set at 55. 

loom is powered on for weaving, the warp tension motor will 
search for its reference home, then return to the tension setting left by the 

. Use the arrow keys to 
change the value, or click in the field and type in the value you 
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Set Warp Tension

arrow to advance the warp. Click the arrow until the 

You can set the tension by entering a number in the field or by using the up 

loom is powered on for weaving, the warp tension motor will 
search for its reference home, then return to the tension setting left by the 

. Use the arrow keys to 
change the value, or click in the field and type in the value you 
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Set Warp Tension 

 

arrow to advance the warp. Click the arrow until the 

You can set the tension by entering a number in the field or by using the up 

search for its reference home, then return to the tension setting left by the 

. Use the arrow keys to 
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Tabby 

TABBY

You may want to weave a tabby
main pattern. The tabby tab allows you to choose the patter
plain weave with the threading you are using. Once you have chosen the 
correct tabby on the Tabby tab, you will be able to switch to it at any point 
by clicking the Tabby button on the Weaving tab. For information on how to 
setup new tab
with pick A. The tabby defaults include both “Odds and Evens” and “Evens 
and Odds.” Choose the best option depending on the last pick before the 
tabby section. 

1) 

2) 
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ABBY 
You may want to weave a tabby
main pattern. The tabby tab allows you to choose the patter
plain weave with the threading you are using. Once you have chosen the 
correct tabby on the Tabby tab, you will be able to switch to it at any point 
by clicking the Tabby button on the Weaving tab. For information on how to 
setup new tabbies, p
with pick A. The tabby defaults include both “Odds and Evens” and “Evens 
and Odds.” Choose the best option depending on the last pick before the 
tabby section.  

 Open the Tabby Tab by clicking on the name. The tabby will only 
show the number of shafts available on your loom.
example was taken on a 40 shaft loom.

 From the drop
threading. Several defaults are a
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You may want to weave a tabby
main pattern. The tabby tab allows you to choose the patter
plain weave with the threading you are using. Once you have chosen the 
correct tabby on the Tabby tab, you will be able to switch to it at any point 
by clicking the Tabby button on the Weaving tab. For information on how to 

bies, please see page
with pick A. The tabby defaults include both “Odds and Evens” and “Evens 
and Odds.” Choose the best option depending on the last pick before the 

the Tabby Tab by clicking on the name. The tabby will only 
show the number of shafts available on your loom.
example was taken on a 40 shaft loom.

From the drop-down menu, choose the tabby to use with your 
threading. Several defaults are a

 

 

You may want to weave a tabby (plain weave)
main pattern. The tabby tab allows you to choose the patter
plain weave with the threading you are using. Once you have chosen the 
correct tabby on the Tabby tab, you will be able to switch to it at any point 
by clicking the Tabby button on the Weaving tab. For information on how to 

lease see page
with pick A. The tabby defaults include both “Odds and Evens” and “Evens 
and Odds.” Choose the best option depending on the last pick before the 

the Tabby Tab by clicking on the name. The tabby will only 
show the number of shafts available on your loom.
example was taken on a 40 shaft loom.

down menu, choose the tabby to use with your 
threading. Several defaults are a

 

 

(plain weave)
main pattern. The tabby tab allows you to choose the patter
plain weave with the threading you are using. Once you have chosen the 
correct tabby on the Tabby tab, you will be able to switch to it at any point 
by clicking the Tabby button on the Weaving tab. For information on how to 

lease see page 53. When selected, the tabby will begin 
with pick A. The tabby defaults include both “Odds and Evens” and “Evens 
and Odds.” Choose the best option depending on the last pick before the 

the Tabby Tab by clicking on the name. The tabby will only 
show the number of shafts available on your loom.
example was taken on a 40 shaft loom.

down menu, choose the tabby to use with your 
threading. Several defaults are available.
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(plain weave) header before beginning your 
main pattern. The tabby tab allows you to choose the patter
plain weave with the threading you are using. Once you have chosen the 
correct tabby on the Tabby tab, you will be able to switch to it at any point 
by clicking the Tabby button on the Weaving tab. For information on how to 

When selected, the tabby will begin 
with pick A. The tabby defaults include both “Odds and Evens” and “Evens 
and Odds.” Choose the best option depending on the last pick before the 

the Tabby Tab by clicking on the name. The tabby will only 
show the number of shafts available on your loom.
example was taken on a 40 shaft loom. 

down menu, choose the tabby to use with your 
vailable. 
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header before beginning your 
main pattern. The tabby tab allows you to choose the pattern that will create 
plain weave with the threading you are using. Once you have chosen the 
correct tabby on the Tabby tab, you will be able to switch to it at any point 
by clicking the Tabby button on the Weaving tab. For information on how to 

When selected, the tabby will begin 
with pick A. The tabby defaults include both “Odds and Evens” and “Evens 
and Odds.” Choose the best option depending on the last pick before the 

the Tabby Tab by clicking on the name. The tabby will only 
show the number of shafts available on your loom. The following 

down menu, choose the tabby to use with your 

Weaving with the Compu-Dobby 5

 Page | 

header before beginning your 
n that will create 

plain weave with the threading you are using. Once you have chosen the 
correct tabby on the Tabby tab, you will be able to switch to it at any point 
by clicking the Tabby button on the Weaving tab. For information on how to 

When selected, the tabby will begin 
with pick A. The tabby defaults include both “Odds and Evens” and “Evens 
and Odds.” Choose the best option depending on the last pick before the 

the Tabby Tab by clicking on the name. The tabby will only 
The following 

down menu, choose the tabby to use with your 
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header before beginning your 
n that will create 

plain weave with the threading you are using. Once you have chosen the 
correct tabby on the Tabby tab, you will be able to switch to it at any point 
by clicking the Tabby button on the Weaving tab. For information on how to 

When selected, the tabby will begin 
with pick A. The tabby defaults include both “Odds and Evens” and “Evens 
and Odds.” Choose the best option depending on the last pick before the 

the Tabby Tab by clicking on the name. The tabby will only 
The following 
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3) 

4) 

Note: 
If the pattern that is showing is not plain weave, you may have chosen the 
wrong tabby. Return to the tabby tab and change the tabby.

Weaving with the Compu

32 

 Return to the weaving tab.

 Click Tabby to switch to the pre
on the weaving tab will change to plain weave and the button will 
change from Tabby to Pattern with red text.
with pick A, whi

If the pattern that is showing is not plain weave, you may have chosen the 
wrong tabby. Return to the tabby tab and change the tabby.
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Return to the weaving tab.

Click Tabby to switch to the pre
on the weaving tab will change to plain weave and the button will 
change from Tabby to Pattern with red text.
with pick A, which is the top pick shown on the Tabby tab.

If the pattern that is showing is not plain weave, you may have chosen the 
wrong tabby. Return to the tabby tab and change the tabby.
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Return to the weaving tab.

Click Tabby to switch to the pre
on the weaving tab will change to plain weave and the button will 
change from Tabby to Pattern with red text.

ch is the top pick shown on the Tabby tab.

If the pattern that is showing is not plain weave, you may have chosen the 
wrong tabby. Return to the tabby tab and change the tabby.

 

 

Return to the weaving tab. 

Click Tabby to switch to the pre-defined tabby.
on the weaving tab will change to plain weave and the button will 
change from Tabby to Pattern with red text.

ch is the top pick shown on the Tabby tab.

If the pattern that is showing is not plain weave, you may have chosen the 
wrong tabby. Return to the tabby tab and change the tabby.

 Compu

 

defined tabby.
on the weaving tab will change to plain weave and the button will 
change from Tabby to Pattern with red text. The tabby will begin 

ch is the top pick shown on the Tabby tab.

If the pattern that is showing is not plain weave, you may have chosen the 
wrong tabby. Return to the tabby tab and change the tabby.
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defined tabby. The pattern showing 
on the weaving tab will change to plain weave and the button will 

The tabby will begin 
ch is the top pick shown on the Tabby tab.

If the pattern that is showing is not plain weave, you may have chosen the 
wrong tabby. Return to the tabby tab and change the tabby. 
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The pattern showing 
on the weaving tab will change to plain weave and the button will 

The tabby will begin 
ch is the top pick shown on the Tabby tab. 

If the pattern that is showing is not plain weave, you may have chosen the 
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Tabby 

The pattern showing 
on the weaving tab will change to plain weave and the button will 

The tabby will begin 

If the pattern that is showing is not plain weave, you may have chosen the 
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Reverse 

5) 

REVERSE

The Reverse
forward. This is NOT used to unweave or to go backwards in your pattern.

This could be used to
the ends of a scarf the same when it is worn.

1) 
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 To return to the pattern, click the Pattern button.

EVERSE 
The Reverse feature flips the pattern upside down and keeps you weaving 
forward. This is NOT used to unweave or to go backwards in your pattern.

This could be used to
the ends of a scarf the same when it is worn.

 Click Reverse to reverse the weaving pattern. This allows you to 
automatically reverse the weaving order of the WIF.
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To return to the pattern, click the Pattern button.

feature flips the pattern upside down and keeps you weaving 
forward. This is NOT used to unweave or to go backwards in your pattern.

This could be used to provide symmetry in a pattern, for example,
the ends of a scarf the same when it is worn.

lick Reverse to reverse the weaving pattern. This allows you to 
automatically reverse the weaving order of the WIF.

 

 

To return to the pattern, click the Pattern button.

feature flips the pattern upside down and keeps you weaving 
forward. This is NOT used to unweave or to go backwards in your pattern.

provide symmetry in a pattern, for example,
the ends of a scarf the same when it is worn.

lick Reverse to reverse the weaving pattern. This allows you to 
automatically reverse the weaving order of the WIF.

 

 

To return to the pattern, click the Pattern button.

feature flips the pattern upside down and keeps you weaving 
forward. This is NOT used to unweave or to go backwards in your pattern.

provide symmetry in a pattern, for example,
the ends of a scarf the same when it is worn.

lick Reverse to reverse the weaving pattern. This allows you to 
automatically reverse the weaving order of the WIF.
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To return to the pattern, click the Pattern button.

feature flips the pattern upside down and keeps you weaving 
forward. This is NOT used to unweave or to go backwards in your pattern.

provide symmetry in a pattern, for example,
the ends of a scarf the same when it is worn. 

lick Reverse to reverse the weaving pattern. This allows you to 
automatically reverse the weaving order of the WIF.

Weaving with the Compu

 

To return to the pattern, click the Pattern button. 

feature flips the pattern upside down and keeps you weaving 
forward. This is NOT used to unweave or to go backwards in your pattern.

provide symmetry in a pattern, for example,

lick Reverse to reverse the weaving pattern. This allows you to 
automatically reverse the weaving order of the WIF. 
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feature flips the pattern upside down and keeps you weaving 
forward. This is NOT used to unweave or to go backwards in your pattern.

provide symmetry in a pattern, for example, keeping

lick Reverse to reverse the weaving pattern. This allows you to 
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feature flips the pattern upside down and keeps you weaving 
forward. This is NOT used to unweave or to go backwards in your pattern. 

ing 

lick Reverse to reverse the weaving pattern. This allows you to 
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2) 

SET THE 

The default range for th
to weave the whole pattern, enter the range of picks you want to use.
you reach the end of the range, the range will repeat. 
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 The button will change to Forward with red text. Click Forward to 
return to the original pattern.

ET THE RANGE

The default range for th
to weave the whole pattern, enter the range of picks you want to use.
you reach the end of the range, the range will repeat. 
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The button will change to Forward with red text. Click Forward to 
return to the original pattern.

ANGE 
The default range for the WIF is from the first to last pick. 
to weave the whole pattern, enter the range of picks you want to use.
you reach the end of the range, the range will repeat. 
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The button will change to Forward with red text. Click Forward to 
return to the original pattern.

e WIF is from the first to last pick. 
to weave the whole pattern, enter the range of picks you want to use.
you reach the end of the range, the range will repeat. 

 

 

The button will change to Forward with red text. Click Forward to 
return to the original pattern. 

e WIF is from the first to last pick. 
to weave the whole pattern, enter the range of picks you want to use.
you reach the end of the range, the range will repeat. 

 Compu

 

The button will change to Forward with red text. Click Forward to 

e WIF is from the first to last pick. 
to weave the whole pattern, enter the range of picks you want to use.
you reach the end of the range, the range will repeat. 
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The button will change to Forward with red text. Click Forward to 

e WIF is from the first to last pick. If you do not want 
to weave the whole pattern, enter the range of picks you want to use.
you reach the end of the range, the range will repeat.  
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 Set the Range

The button will change to Forward with red text. Click Forward to 

If you do not want 
to weave the whole pattern, enter the range of picks you want to use. Once 
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Set the Range 

 

The button will change to Forward with red text. Click Forward to 

 

If you do not want 
Once 
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Set the Range

Use this feature to experiment with different looks from the same WI
You could also choose a small section from a longer pattern to help create a 
set of differing sized items, for example, a table runner and napkins.

1) 

2) 

3) 

The following examples
set as the range
different.
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Set the Range 

Use this feature to experiment with different looks from the same WI
You could also choose a small section from a longer pattern to help create a 
set of differing sized items, for example, a table runner and napkins.

 In the Set Range Area, click Set Range.

 The Set Range window appears.

 Enter the Start and End P

he following examples
set as the range 
different. 
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Use this feature to experiment with different looks from the same WI
You could also choose a small section from a longer pattern to help create a 
set of differing sized items, for example, a table runner and napkins.

In the Set Range Area, click Set Range.

The Set Range window appears.

Enter the Start and End P

he following examples show the full pattern, then
 for the same WIF file

 

 

Use this feature to experiment with different looks from the same WI
You could also choose a small section from a longer pattern to help create a 
set of differing sized items, for example, a table runner and napkins.

In the Set Range Area, click Set Range.

The Set Range window appears.

Enter the Start and End Picks. Click Apply.

show the full pattern, then
for the same WIF file

 

 

Use this feature to experiment with different looks from the same WI
You could also choose a small section from a longer pattern to help create a 
set of differing sized items, for example, a table runner and napkins.

In the Set Range Area, click Set Range.

The Set Range window appears. 

icks. Click Apply.

show the full pattern, then
for the same WIF file. Each pattern appears
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Use this feature to experiment with different looks from the same WI
You could also choose a small section from a longer pattern to help create a 
set of differing sized items, for example, a table runner and napkins.

In the Set Range Area, click Set Range. 

icks. Click Apply. 

show the full pattern, then 1-10 and then 1
. Each pattern appears
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Use this feature to experiment with different looks from the same WI
You could also choose a small section from a longer pattern to help create a 
set of differing sized items, for example, a table runner and napkins.

 

 

10 and then 1
. Each pattern appears slightly
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Use this feature to experiment with different looks from the same WIF file.
You could also choose a small section from a longer pattern to help create a 
set of differing sized items, for example, a table runner and napkins. 

10 and then 1-15 were 
slightly 
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F file. 
You could also choose a small section from a longer pattern to help create a 

15 were 
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Unweave

UNWEAVE

WARNING: 
Anytime you move 
cloth storage beam. This will release the tension on your finished cloth so 
that the loom will not be damaged.

The Unweave button is used when you need to remove some of your weft 
threads. When you press down the treadle, the shed will open 
the reverse order that you wove. 
Unweave is selected.
point, you can use the manual advance buttons in the cloth advance section 
of the Weaving tab to ad
necessary.

1) 
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Unweave 

NWEAVE 
WARNING:  

Anytime you move 
cloth storage beam. This will release the tension on your finished cloth so 
that the loom will not be damaged.

The Unweave button is used when you need to remove some of your weft 
threads. When you press down the treadle, the shed will open 
the reverse order that you wove. 
Unweave is selected.
point, you can use the manual advance buttons in the cloth advance section 
of the Weaving tab to ad
necessary. 

 Take the pin out of the cloth advance beam so that the cloth will 
unwind easily.
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Anytime you move the weaving backwards, you must remove 
cloth storage beam. This will release the tension on your finished cloth so 
that the loom will not be damaged.

The Unweave button is used when you need to remove some of your weft 
threads. When you press down the treadle, the shed will open 
the reverse order that you wove. 
Unweave is selected. Once you have removed the weft back to the desired 
point, you can use the manual advance buttons in the cloth advance section 
of the Weaving tab to adjust your fell line back to the proper point if 

Take the pin out of the cloth advance beam so that the cloth will 
unwind easily. 

 

 

weaving backwards, you must remove 
cloth storage beam. This will release the tension on your finished cloth so 
that the loom will not be damaged.

The Unweave button is used when you need to remove some of your weft 
threads. When you press down the treadle, the shed will open 
the reverse order that you wove. The warp beam will move backwards when 

Once you have removed the weft back to the desired 
point, you can use the manual advance buttons in the cloth advance section 

just your fell line back to the proper point if 

Take the pin out of the cloth advance beam so that the cloth will 

 

 

weaving backwards, you must remove 
cloth storage beam. This will release the tension on your finished cloth so 
that the loom will not be damaged. 

The Unweave button is used when you need to remove some of your weft 
threads. When you press down the treadle, the shed will open 

The warp beam will move backwards when 
Once you have removed the weft back to the desired 

point, you can use the manual advance buttons in the cloth advance section 
just your fell line back to the proper point if 

Take the pin out of the cloth advance beam so that the cloth will 
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weaving backwards, you must remove 
cloth storage beam. This will release the tension on your finished cloth so 

The Unweave button is used when you need to remove some of your weft 
threads. When you press down the treadle, the shed will open 

The warp beam will move backwards when 
Once you have removed the weft back to the desired 

point, you can use the manual advance buttons in the cloth advance section 
just your fell line back to the proper point if 

Take the pin out of the cloth advance beam so that the cloth will 
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weaving backwards, you must remove the pin in the 
cloth storage beam. This will release the tension on your finished cloth so 

The Unweave button is used when you need to remove some of your weft 
threads. When you press down the treadle, the shed will open the picks in 

The warp beam will move backwards when 
Once you have removed the weft back to the desired 

point, you can use the manual advance buttons in the cloth advance section 
just your fell line back to the proper point if 

Take the pin out of the cloth advance beam so that the cloth will 
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the pin in the 
cloth storage beam. This will release the tension on your finished cloth so 

The Unweave button is used when you need to remove some of your weft 
the picks in 

The warp beam will move backwards when 
Once you have removed the weft back to the desired 

point, you can use the manual advance buttons in the cloth advance section 
just your fell line back to the proper point if 

Take the pin out of the cloth advance beam so that the cloth will 
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the pin in the 
cloth storage beam. This will release the tension on your finished cloth so 

The Unweave button is used when you need to remove some of your weft 
the picks in 

The warp beam will move backwards when 
Once you have removed the weft back to the desired 

point, you can use the manual advance buttons in the cloth advance section 

Take the pin out of the cloth advance beam so that the cloth will 
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2) 

3) 

Reverse the Warp
Use this option to adjust the fell line if necessary. 

1) 

2) 

3) 
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 Click Unweave.

 The button will change to Weave with red text. Click Weave to 
return to normal functionality.

verse the Warp
Use this option to adjust the fell line if necessary. 

 Make sure the pin is out of the cloth advance beam so that the cloth 
will unwind easily

 In the software go to the Cloth Advance area. 

 Use the 
warp has 
the fell line
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Click Unweave. 

The button will change to Weave with red text. Click Weave to 
return to normal functionality.

verse the Warp 
Use this option to adjust the fell line if necessary. 

Make sure the pin is out of the cloth advance beam so that the cloth 
will unwind easily

In the software go to the Cloth Advance area. 

Use the down arrow to reverse the warp. Click t
warp has reversed
the fell line. 
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The button will change to Weave with red text. Click Weave to 
return to normal functionality.

Use this option to adjust the fell line if necessary. 

Make sure the pin is out of the cloth advance beam so that the cloth 
will unwind easily 

In the software go to the Cloth Advance area. 

arrow to reverse the warp. Click t
reversed as far as you want it.

 

 

The button will change to Weave with red text. Click Weave to 
return to normal functionality. 

Use this option to adjust the fell line if necessary. 

Make sure the pin is out of the cloth advance beam so that the cloth 

In the software go to the Cloth Advance area. 

arrow to reverse the warp. Click t
as far as you want it.
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The button will change to Weave with red text. Click Weave to 

Use this option to adjust the fell line if necessary.  

Make sure the pin is out of the cloth advance beam so that the cloth 

In the software go to the Cloth Advance area. 

arrow to reverse the warp. Click t
as far as you want it. Use the beater to adjust 
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The button will change to Weave with red text. Click Weave to 

Make sure the pin is out of the cloth advance beam so that the cloth 

In the software go to the Cloth Advance area.  

 

arrow to reverse the warp. Click the arrow until the 
Use the beater to adjust 
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The button will change to Weave with red text. Click Weave to 

Make sure the pin is out of the cloth advance beam so that the cloth 

he arrow until the 
Use the beater to adjust 
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Make sure the pin is out of the cloth advance beam so that the cloth 

he arrow until the 
Use the beater to adjust 
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4) Reset the tension. Depending on how far you have unwoven, you 
may need to rewind the warp onto the warp beam. 

5) Return the pin to the cloth advance beam. 

Note: 
If you cannot find the hole for the pin easily, move the cloth advance beam by 
using the beater until you see the hole. The cloth advance beam will not wind 
on cloth unless the pin is in the hole. 

6) If there is any slack in the cloth you can tighten up by using the 
beater. 

ADJUST THE PICK 
You can change the pick to be woven by using the right or left arrow keys on 
the keyboard, or by entering the exact pick number to weave. If the shed is 
closed, the solenoids will fire to adjust the pick. The display will be adjusted 
to show the changes. Changing the pick with the arrow keys is the fastest 
way to step through the design. 

When a range is set, the pick will “wrap around” when the value would stray 
outside the bounds set by the range. 

When opening the last file you used, most versions of the Compu-Dobby 5 
software will ask you if you want to resume where you left off at your last 
weaving session. If you have an older version, it may not save your last 
pick. In this case, enter the pick you want to start this weaving session with. 

You can also use this feature to start at a different pick then the one you left 
off at for design purposes. 

Note: 
Check the current pick to see what will be opened when you treadle. If the 
current pick is zero, treadle once to advance to the correct pick. 

Change the Pick 
Note: 

Change the pick with the right or left arrow keys while the shed is closed to 
quickly step through the design. 

1) Press the right arrow on the keyboard to increase the pick by one. 
Press the left arrow on the keyboard to decrease the pick by one. 
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Set the Pick

1) 

2) 

3) 

ZOOM IN ON THE 

You can zoom in on the WIF in order to see it in more detail. You can
out on the WIF in order to see more of it.

1) 

The following examples show a weaving tab that is zoomed out, and then 
one that shows it zoomed in.
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Set the Pick 

 In the Pick area, click Set Pick.

 The Set Pick window appears.

 Enter the pick you want to start with and click Apply.

OOM IN ON THE 

You can zoom in on the WIF in order to see it in more detail. You can
out on the WIF in order to see more of it.

 Click the + or 
the WIF file to what you want.

The following examples show a weaving tab that is zoomed out, and then 
one that shows it zoomed in.
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In the Pick area, click Set Pick.

The Set Pick window appears.

Enter the pick you want to start with and click Apply.

OOM IN ON THE WIF
You can zoom in on the WIF in order to see it in more detail. You can
out on the WIF in order to see more of it.

Click the + or – zoom buttons until you have adjusted the view of 
the WIF file to what you want.

The following examples show a weaving tab that is zoomed out, and then 
one that shows it zoomed in.
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In the Pick area, click Set Pick.

The Set Pick window appears.

Enter the pick you want to start with and click Apply.

WIF 
You can zoom in on the WIF in order to see it in more detail. You can
out on the WIF in order to see more of it.

zoom buttons until you have adjusted the view of 
the WIF file to what you want.

The following examples show a weaving tab that is zoomed out, and then 
one that shows it zoomed in. 

 

 

In the Pick area, click Set Pick. 

The Set Pick window appears. 

Enter the pick you want to start with and click Apply.

You can zoom in on the WIF in order to see it in more detail. You can
out on the WIF in order to see more of it. 

zoom buttons until you have adjusted the view of 
the WIF file to what you want. 

The following examples show a weaving tab that is zoomed out, and then 
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Enter the pick you want to start with and click Apply.

You can zoom in on the WIF in order to see it in more detail. You can

zoom buttons until you have adjusted the view of 

 

The following examples show a weaving tab that is zoomed out, and then 
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 Zoom in on the WIF

 

 

Enter the pick you want to start with and click Apply. 

You can zoom in on the WIF in order to see it in more detail. You can

zoom buttons until you have adjusted the view of 

 

The following examples show a weaving tab that is zoomed out, and then 
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Zoom in on the WIF

You can zoom in on the WIF in order to see it in more detail. You can zoom 

zoom buttons until you have adjusted the view of 

The following examples show a weaving tab that is zoomed out, and then 

Dobby 5 User’s Manual 

Zoom in on the WIF 

zoom 

zoom buttons until you have adjusted the view of 

The following examples show a weaving tab that is zoomed out, and then 
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Lock the warp beam

LOCK THE WARP BEAM

There is a button that allows you to lock the warp beam in place. When the 
warp beam is locked, the 

This feature 
with placing wefts while m
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Lock the warp beam 

CK THE WARP BEAM

There is a button that allows you to lock the warp beam in place. When the 
warp beam is locked, the 

This feature could
with placing wefts while m
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CK THE WARP BEAM

There is a button that allows you to lock the warp beam in place. When the 
warp beam is locked, the cloth

could be used by weavers who want to be able to experiment 
with placing wefts while m

 

 

CK THE WARP BEAM 
There is a button that allows you to lock the warp beam in place. When the 

cloth advance is automatically disabled.

be used by weavers who want to be able to experiment 
with placing wefts while manually advancing the cloth and letting off warp. 

 

 

There is a button that allows you to lock the warp beam in place. When the 
advance is automatically disabled.

be used by weavers who want to be able to experiment 
anually advancing the cloth and letting off warp. 
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There is a button that allows you to lock the warp beam in place. When the 
advance is automatically disabled.

be used by weavers who want to be able to experiment 
anually advancing the cloth and letting off warp. 
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There is a button that allows you to lock the warp beam in place. When the 
advance is automatically disabled.

be used by weavers who want to be able to experiment 
anually advancing the cloth and letting off warp. 
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There is a button that allows you to lock the warp beam in place. When the 
advance is automatically disabled. 

be used by weavers who want to be able to experiment 
anually advancing the cloth and letting off warp. 
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There is a button that allows you to lock the warp beam in place. When the 

be used by weavers who want to be able to experiment 
anually advancing the cloth and letting off warp.  
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If you need to treadle through your pattern for some reason, you can use 
this feature to avoid having the warp advance
off the cloth advance without locking the warp beam. See

Note: 
Change the pick with the right or left arrow keys while the shed is closed to 
quickly step through the design. You do not need to lock the warp beam or 
turn off the cloth advance.

1) 

2) 

3) 

 

POWER 

1) 
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If you need to treadle through your pattern for some reason, you can use 
this feature to avoid having the warp advance
off the cloth advance without locking the warp beam. See

Change the pick with the right or left arrow keys while the shed is closed to 
quickly step through the design. You do not need to lock the warp beam or 
turn off the cloth advance.

 Open the software. 

 Click the L

 Click the button again to turn it off.

OWER OFF

 When you are done weaving, click Power Off to return the loom to 
its normal standby state. If you are going to turn off power to the 
loom, shutdown the loom through the software.
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If you need to treadle through your pattern for some reason, you can use 
this feature to avoid having the warp advance
off the cloth advance without locking the warp beam. See

Change the pick with the right or left arrow keys while the shed is closed to 
quickly step through the design. You do not need to lock the warp beam or 
turn off the cloth advance.

Open the software. 

Click the Lock war

Click the button again to turn it off.

FF 
When you are done weaving, click Power Off to return the loom to 
its normal standby state. If you are going to turn off power to the 
loom, shutdown the loom through the software.

Dobby 5 

 

If you need to treadle through your pattern for some reason, you can use 
this feature to avoid having the warp advance
off the cloth advance without locking the warp beam. See

Change the pick with the right or left arrow keys while the shed is closed to 
quickly step through the design. You do not need to lock the warp beam or 
turn off the cloth advance. 

Open the software.  

ock warp beam button.

Click the button again to turn it off.

When you are done weaving, click Power Off to return the loom to 
its normal standby state. If you are going to turn off power to the 
loom, shutdown the loom through the software.

 

 

If you need to treadle through your pattern for some reason, you can use 
this feature to avoid having the warp advance
off the cloth advance without locking the warp beam. See

Change the pick with the right or left arrow keys while the shed is closed to 
quickly step through the design. You do not need to lock the warp beam or 

p beam button. 

Click the button again to turn it off. 

When you are done weaving, click Power Off to return the loom to 
its normal standby state. If you are going to turn off power to the 
loom, shutdown the loom through the software.
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If you need to treadle through your pattern for some reason, you can use 
this feature to avoid having the warp advance, however it is faster to
off the cloth advance without locking the warp beam. See

Change the pick with the right or left arrow keys while the shed is closed to 
quickly step through the design. You do not need to lock the warp beam or 

 

When you are done weaving, click Power Off to return the loom to 
its normal standby state. If you are going to turn off power to the 
loom, shutdown the loom through the software.
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If you need to treadle through your pattern for some reason, you can use 
, however it is faster to

off the cloth advance without locking the warp beam. See page 

Change the pick with the right or left arrow keys while the shed is closed to 
quickly step through the design. You do not need to lock the warp beam or 

 

 

When you are done weaving, click Power Off to return the loom to 
its normal standby state. If you are going to turn off power to the 
loom, shutdown the loom through the software. 
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 Power Off

If you need to treadle through your pattern for some reason, you can use 
, however it is faster to turn 

page 47. 

Change the pick with the right or left arrow keys while the shed is closed to 
quickly step through the design. You do not need to lock the warp beam or 

When you are done weaving, click Power Off to return the loom to 
its normal standby state. If you are going to turn off power to the 
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Power Off 

If you need to treadle through your pattern for some reason, you can use 
turn 

Change the pick with the right or left arrow keys while the shed is closed to 
quickly step through the design. You do not need to lock the warp beam or 

When you are done weaving, click Power Off to return the loom to 
its normal standby state. If you are going to turn off power to the 



Compu-Dobby 5 User’s Manual Other Tabs 

Power Off Page | 43 

OTHER TABS 
  



Other Tabs

Page | 44

FILE T
Files are stored on the loom. The files must be in the WIF format. The file 
tab allows you to open your weaving files or to transfer weaving files to the 
loom. It is the default tab that appears when you open the software.

If you are using Weavepoint, you can use the loom control feature to open 
Weavepoint files directly in 
export your weaving files to the WIF format. With the Compu
are stored directly on the loom. From th
that have been stored on the loom. You can also upload files from your 
computer to the loom for use.

Note: 
If no file is selected, only Transfer to Loom and Open, Upload to Loom, and 
Backup to Local Machine will be avail

Button
Transfer to Loom and Open

Open for Weaving

Rename
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TAB 
Files are stored on the loom. The files must be in the WIF format. The file 
tab allows you to open your weaving files or to transfer weaving files to the 
loom. It is the default tab that appears when you open the software.

are using Weavepoint, you can use the loom control feature to open 
Weavepoint files directly in 
export your weaving files to the WIF format. With the Compu
are stored directly on the loom. From th
that have been stored on the loom. You can also upload files from your 
computer to the loom for use.

If no file is selected, only Transfer to Loom and Open, Upload to Loom, and 
Backup to Local Machine will be avail

Button 
Transfer to Loom and Open

Open for Weaving

Rename 

 

 

Files are stored on the loom. The files must be in the WIF format. The file 
tab allows you to open your weaving files or to transfer weaving files to the 
loom. It is the default tab that appears when you open the software.

are using Weavepoint, you can use the loom control feature to open 
Weavepoint files directly in 
export your weaving files to the WIF format. With the Compu
are stored directly on the loom. From th
that have been stored on the loom. You can also upload files from your 
computer to the loom for use.

If no file is selected, only Transfer to Loom and Open, Upload to Loom, and 
Backup to Local Machine will be avail

Transfer to Loom and Open

Open for Weaving 

 

 

Files are stored on the loom. The files must be in the WIF format. The file 
tab allows you to open your weaving files or to transfer weaving files to the 
loom. It is the default tab that appears when you open the software.

are using Weavepoint, you can use the loom control feature to open 
Weavepoint files directly in AVLDrive
export your weaving files to the WIF format. With the Compu
are stored directly on the loom. From th
that have been stored on the loom. You can also upload files from your 
computer to the loom for use. 

If no file is selected, only Transfer to Loom and Open, Upload to Loom, and 
Backup to Local Machine will be avail

What it does
Transfer to Loom and Open Transfer a file from local storage to the loom 

and open it
Opens the selected file for weaving. You can 
also double
Rename a file

 

 

Files are stored on the loom. The files must be in the WIF format. The file 
tab allows you to open your weaving files or to transfer weaving files to the 
loom. It is the default tab that appears when you open the software.

are using Weavepoint, you can use the loom control feature to open 
AVLDrive. With any other software, you must 

export your weaving files to the WIF format. With the Compu
are stored directly on the loom. From the files tab, you can open WIF files 
that have been stored on the loom. You can also upload files from your 

If no file is selected, only Transfer to Loom and Open, Upload to Loom, and 
Backup to Local Machine will be available. 

What it does 
Transfer a file from local storage to the loom 
and open it. Complete instructions follow.
Opens the selected file for weaving. You can 
also double-click a file to open it for weaving.
Rename a file. For example if you have 

 Compu

 

Files are stored on the loom. The files must be in the WIF format. The file 
tab allows you to open your weaving files or to transfer weaving files to the 
loom. It is the default tab that appears when you open the software.

are using Weavepoint, you can use the loom control feature to open 
. With any other software, you must 

export your weaving files to the WIF format. With the Compu
e files tab, you can open WIF files 

that have been stored on the loom. You can also upload files from your 

If no file is selected, only Transfer to Loom and Open, Upload to Loom, and 

 
Transfer a file from local storage to the loom 

. Complete instructions follow.
Opens the selected file for weaving. You can 

click a file to open it for weaving.
. For example if you have 
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Files are stored on the loom. The files must be in the WIF format. The file 
tab allows you to open your weaving files or to transfer weaving files to the 
loom. It is the default tab that appears when you open the software.

are using Weavepoint, you can use the loom control feature to open 
. With any other software, you must 

export your weaving files to the WIF format. With the Compu-Dobby 5, files 
e files tab, you can open WIF files 

that have been stored on the loom. You can also upload files from your 

If no file is selected, only Transfer to Loom and Open, Upload to Loom, and 

Transfer a file from local storage to the loom 
. Complete instructions follow.

Opens the selected file for weaving. You can 
click a file to open it for weaving.

. For example if you have 
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 File Tab

Files are stored on the loom. The files must be in the WIF format. The file 
tab allows you to open your weaving files or to transfer weaving files to the 
loom. It is the default tab that appears when you open the software. 

are using Weavepoint, you can use the loom control feature to open 
. With any other software, you must 

Dobby 5, files 
e files tab, you can open WIF files 

that have been stored on the loom. You can also upload files from your 

If no file is selected, only Transfer to Loom and Open, Upload to Loom, and 

Transfer a file from local storage to the loom 
. Complete instructions follow. 

Opens the selected file for weaving. You can 
click a file to open it for weaving.

. For example if you have 
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File Tab 

Files are stored on the loom. The files must be in the WIF format. The file 
tab allows you to open your weaving files or to transfer weaving files to the 

are using Weavepoint, you can use the loom control feature to open 
. With any other software, you must 

Dobby 5, files 
e files tab, you can open WIF files 

If no file is selected, only Transfer to Loom and Open, Upload to Loom, and 

 

Transfer a file from local storage to the loom 
 

Opens the selected file for weaving. You can 
click a file to open it for weaving. 



Compu-Dobby 5 User’s Manual

File Tab 

Delete 

Upload to Loom

Download from Loom
Backup to Local Machine

Transfer to Loom and Open
This option allows you to find WIF files on your computer and transfer them 
to the loom storage system for use. The file will be transferred to and also 
opened in the Weaving tab for use.

1) 

2) 
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Upload to Loom 

Download from Loom
Backup to Local Machine

Transfer to Loom and Open
This option allows you to find WIF files on your computer and transfer them 
to the loom storage system for use. The file will be transferred to and also 
opened in the Weaving tab for use.

 Click Transfer to Loom and O
for your device will appear.
computer.

 Navigate to the folder
to use. 
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Download from Loom 
Backup to Local Machine 

Transfer to Loom and Open
This option allows you to find WIF files on your computer and transfer them 
to the loom storage system for use. The file will be transferred to and also 
opened in the Weaving tab for use.

Transfer to Loom and O
for your device will appear.
computer. 

Navigate to the folder
 

 

 

several files with similar names, you might 
rename the file you are actively using so that 
it is easy to find.
Delete a file from the loom
no limits on how many files can be stored, 
deleting files that are
make it easier to find the files you want in the 
list. 
Transfer a file to the loom without opening it.
Complete instructions follow.
For future use
For future use

Transfer to Loom and Open 
This option allows you to find WIF files on your computer and transfer them 
to the loom storage system for use. The file will be transferred to and also 
opened in the Weaving tab for use. 

Transfer to Loom and O
for your device will appear.

Navigate to the folder where you have stored the WIF file you want 

 

 

several files with similar names, you might 
rename the file you are actively using so that 
it is easy to find.
Delete a file from the loom
no limits on how many files can be stored, 
eleting files that are

make it easier to find the files you want in the 
 

Transfer a file to the loom without opening it.
Complete instructions follow.
For future use.

future use.

This option allows you to find WIF files on your computer and transfer them 
to the loom storage system for use. The file will be transferred to and also 

 

Transfer to Loom and Open.
for your device will appear. This screenshot is from a Windows 

where you have stored the WIF file you want 

 

 

several files with similar names, you might 
rename the file you are actively using so that 
it is easy to find. 
Delete a file from the loom
no limits on how many files can be stored, 
eleting files that are no

make it easier to find the files you want in the 

Transfer a file to the loom without opening it.
Complete instructions follow.

. 

. 

This option allows you to find WIF files on your computer and transfer them 
to the loom storage system for use. The file will be transferred to and also 

. The standard open file window 
This screenshot is from a Windows 

where you have stored the WIF file you want 

 

 

several files with similar names, you might 
rename the file you are actively using so that 

Delete a file from the loom. While there are 
no limits on how many files can be stored, 

not being used can 
make it easier to find the files you want in the 

Transfer a file to the loom without opening it.
Complete instructions follow. 

This option allows you to find WIF files on your computer and transfer them 
to the loom storage system for use. The file will be transferred to and also 

The standard open file window 
This screenshot is from a Windows 

where you have stored the WIF file you want 

 Other Tabs
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several files with similar names, you might 
rename the file you are actively using so that 

. While there are 
no limits on how many files can be stored, 

t being used can 
make it easier to find the files you want in the 

Transfer a file to the loom without opening it.

This option allows you to find WIF files on your computer and transfer them 
to the loom storage system for use. The file will be transferred to and also 

The standard open file window 
This screenshot is from a Windows 

 

where you have stored the WIF file you want 
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several files with similar names, you might 
rename the file you are actively using so that 

. While there are 
no limits on how many files can be stored, 

make it easier to find the files you want in the 

Transfer a file to the loom without opening it. 

This option allows you to find WIF files on your computer and transfer them 
to the loom storage system for use. The file will be transferred to and also 

The standard open file window 

where you have stored the WIF file you want 
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3) 

4) 

5) 

Note: 
This process will upload the file to the loom, so the next time you want to use 
this WIF, you can choose it from the File tab.

Upload to Loom
This option will transfer the WIF file to the loo
will not be opened in the Weaving tab.

1) 

2) 

3) 

4) 

5) 
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 Choose the desired WIF file from the folder

 Click Op

 The WIF file will open in the Weaving Tab

This process will upload the file to the loom, so the next time you want to use 
this WIF, you can choose it from the File tab.

Upload to Loom
This option will transfer the WIF file to the loo
will not be opened in the Weaving tab.

 Click Upload to Loom
device will appear.

 Navigate to the folder where you have stored the WIF file
to use. 

 Choose the desired WIF file from the folder

 Click Open.

 The WIF file will appear in the list of files in the Files tab.

 

 

Choose the desired WIF file from the folder

Click Open. 

The WIF file will open in the Weaving Tab

This process will upload the file to the loom, so the next time you want to use 
this WIF, you can choose it from the File tab.

Upload to Loom 
This option will transfer the WIF file to the loo
will not be opened in the Weaving tab.

Upload to Loom
device will appear.

Navigate to the folder where you have stored the WIF file
 

Choose the desired WIF file from the folder

Click Open. 

The WIF file will appear in the list of files in the Files tab.

 

 

Choose the desired WIF file from the folder

The WIF file will open in the Weaving Tab

This process will upload the file to the loom, so the next time you want to use 
this WIF, you can choose it from the File tab.

This option will transfer the WIF file to the loo
will not be opened in the Weaving tab.

Upload to Loom. The standard open file window for your 
device will appear. This screenshot is from a Windows computer.

Navigate to the folder where you have stored the WIF file

Choose the desired WIF file from the folder

The WIF file will appear in the list of files in the Files tab.

 

 

Choose the desired WIF file from the folder

The WIF file will open in the Weaving Tab

This process will upload the file to the loom, so the next time you want to use 
this WIF, you can choose it from the File tab.

This option will transfer the WIF file to the loo
will not be opened in the Weaving tab. 

The standard open file window for your 
This screenshot is from a Windows computer.

Navigate to the folder where you have stored the WIF file

Choose the desired WIF file from the folder

The WIF file will appear in the list of files in the Files tab.

 Compu

 

Choose the desired WIF file from the folder by clicking on it

The WIF file will open in the Weaving Tab in AVLDrive

This process will upload the file to the loom, so the next time you want to use 
this WIF, you can choose it from the File tab. 

This option will transfer the WIF file to the loom for use in the future, but it 

The standard open file window for your 
This screenshot is from a Windows computer.

Navigate to the folder where you have stored the WIF file

Choose the desired WIF file from the folder by clicking on it

The WIF file will appear in the list of files in the Files tab.
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by clicking on it

AVLDrive. 

This process will upload the file to the loom, so the next time you want to use 

m for use in the future, but it 

The standard open file window for your 
This screenshot is from a Windows computer.

Navigate to the folder where you have stored the WIF file

by clicking on it

The WIF file will appear in the list of files in the Files tab.
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 File Ta

by clicking on it. 

 

This process will upload the file to the loom, so the next time you want to use 

m for use in the future, but it 

The standard open file window for your 
This screenshot is from a Windows computer.

 

Navigate to the folder where you have stored the WIF file you want 

by clicking on it. 

The WIF file will appear in the list of files in the Files tab. 
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File Tab 

This process will upload the file to the loom, so the next time you want to use 

m for use in the future, but it 

This screenshot is from a Windows computer. 

you want 
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Options Tab

OPTIONS

This tab allows you to set several options for your loom.

1) 

2) 

 

Loom Name
The name of your loom. Changing the name will change the address you 
need to type to access your loom.
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Options Tab 

PTIONS TAB

This tab allows you to set several options for your loom.

 To activate an option, check

 To turn off an option, uncheck the box.

Loom Name 
The name of your loom. Changing the name will change the address you 
need to type to access your loom.
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AB 
This tab allows you to set several options for your loom.

To activate an option, check

To turn off an option, uncheck the box.

The name of your loom. Changing the name will change the address you 
need to type to access your loom.

  

 

 

This tab allows you to set several options for your loom.

To activate an option, check

To turn off an option, uncheck the box.

The name of your loom. Changing the name will change the address you 
need to type to access your loom. See page 

 

 

This tab allows you to set several options for your loom.

To activate an option, check the box.

To turn off an option, uncheck the box.

The name of your loom. Changing the name will change the address you 
See page 15

 

 

This tab allows you to set several options for your loom.

the box. 

To turn off an option, uncheck the box. 

The name of your loom. Changing the name will change the address you 
15 for complete instructions.

 

 

This tab allows you to set several options for your loom. 

The name of your loom. Changing the name will change the address you 
for complete instructions.

 Other Tabs

 Page | 

The name of your loom. Changing the name will change the address you 
for complete instructions.
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The name of your loom. Changing the name will change the address you 
for complete instructions. 
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History Percent
Move the percentage bar to indicate 
devoted to history. The following examples show a screen with 
and less
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History Percent
e the percentage bar to indicate 

devoted to history. The following examples show a screen with 
less history. 

 

 

 

History Percent 
e the percentage bar to indicate 

devoted to history. The following examples show a screen with 
 

  

 

 

e the percentage bar to indicate 
devoted to history. The following examples show a screen with 

 

 

e the percentage bar to indicate how much of the screen should be 
devoted to history. The following examples show a screen with 

 Compu

 

how much of the screen should be 
devoted to history. The following examples show a screen with 
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how much of the screen should be 
devoted to history. The following examples show a screen with more
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 Options Tab

how much of the screen should be 
more history 
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Options Tab 

history 
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Options Tab

Show repeat counter
Shows the repeat number in the software.
screen with the repeat counter on and with it off.

 

Dobby 5 User’s Manual

Options Tab 

Show repeat counter
Shows the repeat number in the software.
screen with the repeat counter on and with it off.
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Show repeat counter 
Shows the repeat number in the software.
screen with the repeat counter on and with it off.

  

 

 

Shows the repeat number in the software.
screen with the repeat counter on and with it off.

 

 

Shows the repeat number in the software. The following examples show th
screen with the repeat counter on and with it off.

 

 

The following examples show th
screen with the repeat counter on and with it off. 

 

 

The following examples show th
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The following examples show th
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The following examples show the 
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Show color bar
The color bar to the right of the draft will appear.
show the color bar on and the color bar off.
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Show color bar 
The color bar to the right of the draft will appear.
show the color bar on and the color bar off.

 

 

 

 
The color bar to the right of the draft will appear.
show the color bar on and the color bar off.

  

 

 

The color bar to the right of the draft will appear.
show the color bar on and the color bar off.

 

 

The color bar to the right of the draft will appear.
show the color bar on and the color bar off. 
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The color bar to the right of the draft will appear. The following examples 
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The following examples 
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 Options Tab

The following examples 
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Options Tab 

The following examples 
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Options Tab

Show drawdown in color
Allows you to view the WIF in 
the same color warp and weft. 
and the WIF with the color option turned off.
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Options Tab 

Show drawdown in color
Allows you to view the WIF in 
the same color warp and weft. 
and the WIF with the color option turned off.
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Show drawdown in color
Allows you to view the WIF in 
the same color warp and weft. 
and the WIF with the color option turned off.

  

 

 

Show drawdown in color 
Allows you to view the WIF in color.
the same color warp and weft. The following examples show the WIF in color 
and the WIF with the color option turned off.

 

 

color. This can be helpful when the design has 
The following examples show the WIF in color 

and the WIF with the color option turned off. 

 

 

This can be helpful when the design has 
The following examples show the WIF in color 

 

 

 

This can be helpful when the design has 
The following examples show the WIF in color 

 Other Tabs

 Page | 

This can be helpful when the design has 
The following examples show the WIF in color 
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This can be helpful when the design has 
The following examples show the WIF in color 
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Show numbers in liftplan
When you are zoomed in far enough on the WIF, you will be
harness numbers
option off.
show legible numbers.
page show har

Fabric scrolls down
If selected the fabric will scroll down on the screen as you weave, if not, the 
fabric will scroll up.
other screenshots in this manual show the fabric scrolling up.

Use metric (cm) for advance
This option a
default is imperial (inches).

Tabs 
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Show numbers in liftplan
When you are zoomed in far enough on the WIF, you will be
harness numbers
option off. This is also what will appear if the file is zoomed too far out to 
show legible numbers.
page show harness numbers.

Fabric scrolls down
If selected the fabric will scroll down on the screen as you weave, if not, the 
fabric will scroll up.
other screenshots in this manual show the fabric scrolling up.

Use metric (cm) for advance
This option allows you to use the metric system
default is imperial (inches).

 

 

Show numbers in liftplan
When you are zoomed in far enough on the WIF, you will be
harness numbers. The following example shows the WIF or

This is also what will appear if the file is zoomed too far out to 
show legible numbers. The examples for the color drawdown on the previous 

ness numbers.

Fabric scrolls down 
If selected the fabric will scroll down on the screen as you weave, if not, the 
fabric will scroll up. The following example shows this option turned on. The 
other screenshots in this manual show the fabric scrolling up.

Use metric (cm) for advance
llows you to use the metric system

default is imperial (inches).

 

 

Show numbers in liftplan 
When you are zoomed in far enough on the WIF, you will be

. The following example shows the WIF or
This is also what will appear if the file is zoomed too far out to 

The examples for the color drawdown on the previous 
ness numbers. 

If selected the fabric will scroll down on the screen as you weave, if not, the 
The following example shows this option turned on. The 

other screenshots in this manual show the fabric scrolling up.

Use metric (cm) for advance 
llows you to use the metric system

default is imperial (inches). 

 

 

When you are zoomed in far enough on the WIF, you will be
. The following example shows the WIF or

This is also what will appear if the file is zoomed too far out to 
The examples for the color drawdown on the previous 

If selected the fabric will scroll down on the screen as you weave, if not, the 
The following example shows this option turned on. The 

other screenshots in this manual show the fabric scrolling up.

llows you to use the metric system

 Compu

 

When you are zoomed in far enough on the WIF, you will be
. The following example shows the WIF or

This is also what will appear if the file is zoomed too far out to 
The examples for the color drawdown on the previous 

If selected the fabric will scroll down on the screen as you weave, if not, the 
The following example shows this option turned on. The 

other screenshots in this manual show the fabric scrolling up.

llows you to use the metric system for the cloth advance
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When you are zoomed in far enough on the WIF, you will be able to see the 
. The following example shows the WIF or if you

This is also what will appear if the file is zoomed too far out to 
The examples for the color drawdown on the previous 

If selected the fabric will scroll down on the screen as you weave, if not, the 
The following example shows this option turned on. The 

other screenshots in this manual show the fabric scrolling up. 

for the cloth advance
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 Options Tab

able to see the 
if you turn this 

This is also what will appear if the file is zoomed too far out to 
The examples for the color drawdown on the previous 

If selected the fabric will scroll down on the screen as you weave, if not, the 
The following example shows this option turned on. The 

for the cloth advance. The 
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Options Tab 

able to see the 
turn this 

This is also what will appear if the file is zoomed too far out to 
The examples for the color drawdown on the previous 

 

If selected the fabric will scroll down on the screen as you weave, if not, the 
The following example shows this option turned on. The 

 

. The 
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Tabby Tab

Enable Cloth Beam Advance
This option a
beam advance is als
to halt the cloth advance when stepping through the design.

TABBY

This tab allows you to set up or use a tabby
are included. If your threading requires a tabby pa
you can add a new tabby. You can also edit, delete, or rename existing 
tabbies.

1) 

2) 

Add a Tabby
Once you have added a new tabby, you will need to edit so that the correct 
harnesses rise on each lift.
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Tabby Tab 

Enable Cloth Beam Advance
This option allow
beam advance is als
to halt the cloth advance when stepping through the design.

ABBY TAB 
This tab allows you to set up or use a tabby
are included. If your threading requires a tabby pa
you can add a new tabby. You can also edit, delete, or rename existing 
tabbies. 

 With the 

 To select a tabby, choose it from the drop
that appears in the tab is the one 
Tabby button is clicked on the Weaving tab.

Add a Tabby 
Once you have added a new tabby, you will need to edit so that the correct 
harnesses rise on each lift.
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Enable Cloth Beam Advance
llows you to turn on or off the clo

beam advance is also turned off if the warp beam is locked.
to halt the cloth advance when stepping through the design.

 
This tab allows you to set up or use a tabby
are included. If your threading requires a tabby pa
you can add a new tabby. You can also edit, delete, or rename existing 

With the AVLDrive software

To select a tabby, choose it from the drop
that appears in the tab is the one 
Tabby button is clicked on the Weaving tab.

Once you have added a new tabby, you will need to edit so that the correct 
harnesses rise on each lift.

 

 

Enable Cloth Beam Advance 
s you to turn on or off the clo

o turned off if the warp beam is locked.
to halt the cloth advance when stepping through the design.

This tab allows you to set up or use a tabby
are included. If your threading requires a tabby pa
you can add a new tabby. You can also edit, delete, or rename existing 

AVLDrive software

To select a tabby, choose it from the drop
that appears in the tab is the one 
Tabby button is clicked on the Weaving tab.

Once you have added a new tabby, you will need to edit so that the correct 
harnesses rise on each lift. 

 

 

s you to turn on or off the clo
o turned off if the warp beam is locked.

to halt the cloth advance when stepping through the design.

This tab allows you to set up or use a tabby (plain weave)
are included. If your threading requires a tabby pa
you can add a new tabby. You can also edit, delete, or rename existing 

AVLDrive software open, click Tabby.

To select a tabby, choose it from the drop
that appears in the tab is the one that will be selected when the 
Tabby button is clicked on the Weaving tab.

Once you have added a new tabby, you will need to edit so that the correct 

 

 

s you to turn on or off the cloth beam advance.
o turned off if the warp beam is locked.

to halt the cloth advance when stepping through the design.

(plain weave)
are included. If your threading requires a tabby pattern that is not included, 
you can add a new tabby. You can also edit, delete, or rename existing 

open, click Tabby.

To select a tabby, choose it from the drop-down menu. The tabby 
that will be selected when the 

Tabby button is clicked on the Weaving tab. 

Once you have added a new tabby, you will need to edit so that the correct 

 

 

beam advance.
o turned off if the warp beam is locked. This can be used 

to halt the cloth advance when stepping through the design. 

(plain weave). Several defaults 
ttern that is not included, 

you can add a new tabby. You can also edit, delete, or rename existing 

open, click Tabby. 

down menu. The tabby 
that will be selected when the 

Once you have added a new tabby, you will need to edit so that the correct 
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Several defaults 
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Once you have added a new tabby, you will need to edit so that the correct 
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 Click Add

 Enter the name of the Tabby

 Click OK.

 

 

 

Click Add. 

Enter the name of the Tabby

OK. 

  

 

 

Enter the name of the Tabby

 

 

Enter the name of the Tabby. 
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Edit a Tabby 

 Choose the Tabby from the drop

 Click Edit. The background color of the tabby will change.

 Click the harnesses that should rise on each lift.
A and the bottom line is pick B.
Tabby is ch

 When you are done, click Edit again.
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Choose the Tabby from the drop

Click Edit. The background color of the tabby will change.

Click the harnesses that should rise on each lift.
A and the bottom line is pick B.
Tabby is chosen on the weaving tab.

When you are done, click Edit again.

  

 

 

Choose the Tabby from the drop

Click Edit. The background color of the tabby will change.

Click the harnesses that should rise on each lift.
A and the bottom line is pick B.

osen on the weaving tab.

When you are done, click Edit again.

 

 

Choose the Tabby from the drop-down list.

Click Edit. The background color of the tabby will change.

Click the harnesses that should rise on each lift.
A and the bottom line is pick B. Pick A is the starting pick when 

osen on the weaving tab.

When you are done, click Edit again.

 

 

down list. 

Click Edit. The background color of the tabby will change.

Click the harnesses that should rise on each lift.
Pick A is the starting pick when 

osen on the weaving tab. 

When you are done, click Edit again. 

 

 

Click Edit. The background color of the tabby will change.

Click the harnesses that should rise on each lift. The top line is pick 
Pick A is the starting pick when 
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The Odds and Evens tabby cannot be deleted.

1) 

2) 

3) 

Rename a Tabby
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Delete a Tabby 

The Odds and Evens tabby cannot be deleted.

 Choose the Tabby from the drop

 Click Delete.

 Click OK at the confirmation window.

Rename a Tabby

 Choose a Tabby 

 Click Rename.

 Enter the new name in the window and click OK.

 

 

 

 

The Odds and Evens tabby cannot be deleted.

Choose the Tabby from the drop

Click Delete. 

Click OK at the confirmation window.

Rename a Tabby 

Choose a Tabby from the drop

Click Rename. 

Enter the new name in the window and click OK.

  

 

 

The Odds and Evens tabby cannot be deleted.

Choose the Tabby from the drop

Click OK at the confirmation window.

from the drop

Enter the new name in the window and click OK.

 

 

The Odds and Evens tabby cannot be deleted.

Choose the Tabby from the drop-down list.

Click OK at the confirmation window.

from the drop-down list.

Enter the new name in the window and click OK.
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The Odds and Evens tabby cannot be deleted. 

down list. 

Click OK at the confirmation window. 

down list. 

Enter the new name in the window and click OK.

Compu-Dobby 5 User’s Manual

 

 

 

Enter the new name in the window and click OK. 
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Use a Tabby
When you change the tabby in the drop
that will be used by the loom when you click Tabby on the Weaving tab.
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Tabby Tab 

Use a Tabby 
When you change the tabby in the drop
that will be used by the loom when you click Tabby on the Weaving tab.

 Open the Tab
show the number of shafts available on your loom.

 From the drop
threading. Several defaults are available.
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When you change the tabby in the drop
that will be used by the loom when you click Tabby on the Weaving tab.

Open the Tabby Tab by clicking on the name. The tabby will only 
show the number of shafts available on your loom.

From the drop-down menu, choose the tabby to use with your 
threading. Several defaults are available.

 

 

When you change the tabby in the drop
that will be used by the loom when you click Tabby on the Weaving tab.

by Tab by clicking on the name. The tabby will only 
show the number of shafts available on your loom.

down menu, choose the tabby to use with your 
threading. Several defaults are available.

 

 

When you change the tabby in the drop-down menu, you change the tabby 
that will be used by the loom when you click Tabby on the Weaving tab.

by Tab by clicking on the name. The tabby will only 
show the number of shafts available on your loom.

down menu, choose the tabby to use with your 
threading. Several defaults are available.

 

 

down menu, you change the tabby 
that will be used by the loom when you click Tabby on the Weaving tab.

by Tab by clicking on the name. The tabby will only 
show the number of shafts available on your loom.

down menu, choose the tabby to use with your 
threading. Several defaults are available. 

 

 

down menu, you change the tabby 
that will be used by the loom when you click Tabby on the Weaving tab.

by Tab by clicking on the name. The tabby will only 
show the number of shafts available on your loom. 

down menu, choose the tabby to use with your 

 Other Tabs

 Page | 

down menu, you change the tabby 
that will be used by the loom when you click Tabby on the Weaving tab. 

by Tab by clicking on the name. The tabby will only 

down menu, choose the tabby to use with your 

 

Other Tabs 

Page | 57 

down menu, you change the tabby 
 

by Tab by clicking on the name. The tabby will only 

 



Other Tabs

Page | 58

UTILITIES

This tab allows you to perform severa

 
Button
Check for update

Fetch configuration

Show Log

Shutdown
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TILITIES 
This tab allows you to perform severa

Button 
Check for update

Fetch configuration

Show Log 

Shutdown 

 

 

 

This tab allows you to perform severa

What it does
Check for update Checks to see if there are updates for the loom 

software. The loom must be connected to the 
internet.

Fetch configuration Gets configuration information for your software. 
The loom must 
click this when told to by AVL
Displays a log of software events. 
be selected and copied to send to AVL for 
diagnostics
to the internet, the inf
email automatically.
Shuts down the loom safely so that it can be 
removed from power.

  

 

 

This tab allows you to perform severa

What it does
Checks to see if there are updates for the loom 
software. The loom must be connected to the 
internet. 
Gets configuration information for your software. 
The loom must 
click this when told to by AVL
Displays a log of software events. 
be selected and copied to send to AVL for 
diagnostics
to the internet, the inf
email automatically.
Shuts down the loom safely so that it can be 
removed from power.

 

 

This tab allows you to perform several operations for your loom.

What it does 
Checks to see if there are updates for the loom 
software. The loom must be connected to the 

Gets configuration information for your software. 
The loom must be connected to the internet.
click this when told to by AVL
Displays a log of software events. 
be selected and copied to send to AVL for 
diagnostics if necessary.
to the internet, the inf
email automatically.
Shuts down the loom safely so that it can be 
removed from power.
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l operations for your loom.

Checks to see if there are updates for the loom 
software. The loom must be connected to the 

Gets configuration information for your software. 
be connected to the internet.

click this when told to by AVL
Displays a log of software events. 
be selected and copied to send to AVL for 

if necessary. If the loom is connected 
to the internet, the information can be sent by 
email automatically. 
Shuts down the loom safely so that it can be 
removed from power. 
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l operations for your loom.

Checks to see if there are updates for the loom 
software. The loom must be connected to the 

Gets configuration information for your software. 
be connected to the internet.

click this when told to by AVL personnel
Displays a log of software events. This window can 
be selected and copied to send to AVL for 

If the loom is connected 
ormation can be sent by 

Shuts down the loom safely so that it can be 
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 Utilities

l operations for your loom. 

Checks to see if there are updates for the loom 
software. The loom must be connected to the 

Gets configuration information for your software. 
be connected to the internet. Only 

personnel.  
This window can 

be selected and copied to send to AVL for 
If the loom is connected 

ormation can be sent by 

Shuts down the loom safely so that it can be 

Dobby 5 User’s Manual 

Utilities 

 

Checks to see if there are updates for the loom 

Gets configuration information for your software. 
Only 

This window can 

If the loom is connected 
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IAGNOSTICS

This tab allows you to view information about your solenoids.
information is needed, you will be directed to vie
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IAGNOSTICS 
This tab allows you to view information about your solenoids.
information is needed, you will be directed to vie

 

 

This tab allows you to view information about your solenoids.
information is needed, you will be directed to vie

 

 

This tab allows you to view information about your solenoids.
information is needed, you will be directed to vie

 

 

This tab allows you to view information about your solenoids.
information is needed, you will be directed to view it by AVL personnel.
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USING A TABLET WITH COMPU-DOBBY 5 
Sometimes it is difficult to find the right place to put a computer for weaving 
on your loom. It seems like it is either in the way, at risk of an errant fly 
shuttle, or too far out of your normal visual range. Putting it on a chair next 
to the loom is a bit too low and requires you to turn too so far that you have 
trouble keeping your rhythm. 

One solution is to use a tablet. A tablet is a great way to weave with the 
Compu-Dobby 5. With the addition of a mounting arm it can be positioned so 
that it is at the correct height while not obstructing your view of the action 
of the loom. And it can be moved out of the way with just a push. 

AVL does not recommend specific tablets or operating systems. There are 
many manufacturers and models to choose from; too many for us to 
monitor. With the operating systems in common use today, iPads are able to 
use the “loomName.local” style of address. However, the Android tablets do 
not support “.local” so the standard IP address will need to be used. See 
page 16 for more information about the loom name and IP addresses. 

Choosing an arm  
The first thing is to choose how you will attach the arm to the loom. Many 
arms attach with a clamp while some will need screw holes in the frame of 
the loom. A clamp is not usually as stable as a more permanent mounting 
and if you want to be able to move the tablet aside with a quick swipe of the 
hand, it may not be the best choice. 

Another consideration is the capacity of the arm. If you are thinking of using 
a large tablet like the 13” iPad, many of the arms cannot support that size 
tablet. With the mechanical motion of the loom, you will need a fairly robust 
arm to keep it from drooping. So, check that both the size and the weight 
capacity of the arm are sufficient. 

Choosing a tablet 
The tablet needs a minimum resolution of 1024 x 768 pixels. On the iPad 
Retina displays that translates to needing 2048 x 1536 pixels. We have 
followed industry standards while creating AVLDrive so the tablet needs a 
browser that is consistent with current standards.  

A USB cable connection is not required. The loom will automatically connect 
to your router (if it has been configured to do so) or it will create its own 
private network. See page 11 and following for more information. 
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Reset the connection
Unlike computers many tablets are designed to be turned off and on without 
disturbing existing connections. In many cases, when you are fi
AVLDrive
happens automatically with computers, but because of the difference in the 
way connections are handled by tablets, it becomes a manual step. If you 
forget, the next t
get a busy

1) 

2) 

3) 

4) 

COMPU

The Compu
may indicate is unsafe. Since no personal information is passed over the 
connection, additional security is not required.
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Dobby 5 Connection Information

Reset the connection
Unlike computers many tablets are designed to be turned off and on without 
disturbing existing connections. In many cases, when you are fi
AVLDrive on a tablet
happens automatically with computers, but because of the difference in the 
way connections are handled by tablets, it becomes a manual step. If you 
forget, the next t

a busy message, and you can send a reset message at that time.

 When connecting to the loom, you receive the message below.

 Enter “/reset” after the URL or IP address in your web browser. 

 Refresh your page. 

 Once you receive the notification that the “current user has been 
logged out”, simply reenter your normal URL or IP address. 

OMPU-DOBBY 

The Compu-Dobby 5 uses a connection known as “http,” which your browser 
indicate is unsafe. Since no personal information is passed over the 

connection, additional security is not required.

Dobby 5 User’s Manual 

Dobby 5 Connection Information

Reset the connection 
Unlike computers many tablets are designed to be turned off and on without 
disturbing existing connections. In many cases, when you are fi

on a tablet you will need to 
happens automatically with computers, but because of the difference in the 
way connections are handled by tablets, it becomes a manual step. If you 
forget, the next time you attempt to connect to the loom you will probably 

message, and you can send a reset message at that time.

When connecting to the loom, you receive the message below.

Enter “/reset” after the URL or IP address in your web browser. 

esh your page. 

Once you receive the notification that the “current user has been 
logged out”, simply reenter your normal URL or IP address. 

OBBY 5 C
Dobby 5 uses a connection known as “http,” which your browser 

indicate is unsafe. Since no personal information is passed over the 
connection, additional security is not required.

 

Dobby 5 Connection Information 

Unlike computers many tablets are designed to be turned off and on without 
disturbing existing connections. In many cases, when you are fi

you will need to 
happens automatically with computers, but because of the difference in the 
way connections are handled by tablets, it becomes a manual step. If you 

ime you attempt to connect to the loom you will probably 
message, and you can send a reset message at that time.

When connecting to the loom, you receive the message below.

Enter “/reset” after the URL or IP address in your web browser. 

esh your page.  

Once you receive the notification that the “current user has been 
logged out”, simply reenter your normal URL or IP address. 

CONNECTION 

Dobby 5 uses a connection known as “http,” which your browser 
indicate is unsafe. Since no personal information is passed over the 

connection, additional security is not required.

 

 

Unlike computers many tablets are designed to be turned off and on without 
disturbing existing connections. In many cases, when you are fi

you will need to reset the connection for the loom
happens automatically with computers, but because of the difference in the 
way connections are handled by tablets, it becomes a manual step. If you 

ime you attempt to connect to the loom you will probably 
message, and you can send a reset message at that time.

When connecting to the loom, you receive the message below.

Enter “/reset” after the URL or IP address in your web browser. 

Once you receive the notification that the “current user has been 
logged out”, simply reenter your normal URL or IP address. 

ONNECTION I
Dobby 5 uses a connection known as “http,” which your browser 

indicate is unsafe. Since no personal information is passed over the 
connection, additional security is not required.

 

 

Unlike computers many tablets are designed to be turned off and on without 
disturbing existing connections. In many cases, when you are fi

reset the connection for the loom
happens automatically with computers, but because of the difference in the 
way connections are handled by tablets, it becomes a manual step. If you 

ime you attempt to connect to the loom you will probably 
message, and you can send a reset message at that time.

When connecting to the loom, you receive the message below.

Enter “/reset” after the URL or IP address in your web browser. 

Once you receive the notification that the “current user has been 
logged out”, simply reenter your normal URL or IP address. 

INFORMATION

Dobby 5 uses a connection known as “http,” which your browser 
indicate is unsafe. Since no personal information is passed over the 

connection, additional security is not required. 

 

 

Unlike computers many tablets are designed to be turned off and on without 
disturbing existing connections. In many cases, when you are fi

reset the connection for the loom
happens automatically with computers, but because of the difference in the 
way connections are handled by tablets, it becomes a manual step. If you 

ime you attempt to connect to the loom you will probably 
message, and you can send a reset message at that time.

When connecting to the loom, you receive the message below.

 

Enter “/reset” after the URL or IP address in your web browser. 

Once you receive the notification that the “current user has been 
logged out”, simply reenter your normal URL or IP address. 

NFORMATION 
Dobby 5 uses a connection known as “http,” which your browser 

indicate is unsafe. Since no personal information is passed over the 
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Unlike computers many tablets are designed to be turned off and on without 
disturbing existing connections. In many cases, when you are finished with 

reset the connection for the loom. This 
happens automatically with computers, but because of the difference in the 
way connections are handled by tablets, it becomes a manual step. If you 

ime you attempt to connect to the loom you will probably 
message, and you can send a reset message at that time. 

When connecting to the loom, you receive the message below. 

Enter “/reset” after the URL or IP address in your web browser.  

 

Once you receive the notification that the “current user has been 
logged out”, simply reenter your normal URL or IP address.  

 
Dobby 5 uses a connection known as “http,” which your browser 

indicate is unsafe. Since no personal information is passed over the 
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Unlike computers many tablets are designed to be turned off and on without 
nished with 

. This 
happens automatically with computers, but because of the difference in the 
way connections are handled by tablets, it becomes a manual step. If you 

ime you attempt to connect to the loom you will probably 

 

Once you receive the notification that the “current user has been 

Dobby 5 uses a connection known as “http,” which your browser 
indicate is unsafe. Since no personal information is passed over the 



Appendix Compu-Dobby 5 User’s Manual 

Page | 64 Send Troubleshooting Information to AVL 

SEND TROUBLESHOOTING INFORMATION TO AVL 
If you are having problems with your loom, AVL may ask you to send the log 
file generated by the program to them in order to figure out the problem. In 
some cases, the log file may be so large that you have problems sending it. 
Follow these instructions to make the log file easier to handle. In order to 
use this option, you will need to be able to recreate the issue. 

1) Enter “/reboot” after the URL or IP address in your web browser. 
The loom should reboot - this clears the log file. 

Note: 
The option to reboot the loom was added in v.1.2.0. If your loom is on a 
previous version, you will need to shutdown the loom completely, then turn it 
back on. 

2) Wait for the loom to reboot and for the network to reconnect. This 
may take a couple of minutes. 

3) Reload AVLDrive. The reboot will cause the browser to disconnect. 

4) Perform the actions in the software or on the loom that causes the 
problem. Repeat the actions a few times. 

5) Write an email to AVL explaining the problem. In the email, explain 
what actions you take, what results and error messages you 
receive, and how many times the problem occurred. 

6) Choose the Utilities tab. 
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7) 

8) 

9) 
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 Click Show Log

 Select all

 Copy the log file and 
sales@avlusa.com
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Show Log. 

elect all of the text in the log file.

Copy the log file and 
sales@avlusa.com

 

Send Troubleshooting Information to AVL 

of the text in the log file.

Copy the log file and paste 
sales@avlusa.com.

 

 

of the text in the log file. 

paste into the email

 

 

into the email. Sen

 

 

nd the email to 
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AVL CUSTOMER SERVICE 
AVL offers free technical support to the original owner of all our looms.This 
means if you ever have a problem, you can call, fax, or e-mail us and we’ll 
help you find a solution.Please take advantage of this service; your 
satisfaction is extremely important to us. 

Customer Service Phone: (530) 893-4915 
Fax:(530) 893-1372 

E-Mail:sales@avlusa.com 

AVL WARRANTIES 
Limited Warranty:The benefits of this warranty accrue solely to the original purchaser of AVL Looms, 
Inc. products, as defined below. 
 
Your warranty covers: 
 
New Looms: AVL Looms, Inc., a California corporation (“AVL”) warrants to the original purchaser of any 
AVL loom (each, a "Product") that the Product will be free from defects in materials and workmanship 
during the limited warranty period described herein. The limited warranty coverage begins (a) the day 
the Product is installed if installed by a professional from AVL, or (b) on the date of shipment from AVL 
to the original purchaser if the Product is not installed by AVL (the “Effective Date”). Except as set forth 
under the section entitled “What is Excluded?” below, AVL will, for a period of two (2) years from the 
Effective Date (the “Original Warranty Period”), repair or replace the defective part(s) of the Product with 
a repaired, renewed, or comparable part (whichever is deemed necessary or proper by AVL) if it 
becomes defective or inoperative or fails to perform according to AVL’s specifications. Any repair during 
the Original Warranty Period will be carried out without charge to you for parts (except applicable taxes, 
if any). You will be responsible for all labor in connection with installation of the parts and service upon 
the Product, as well as the cost of shipping involved. 

 
New Accessories, Loom Upgrade Parts, and Replacement Parts:Subject to the limitation contained in 
subsection (i) under the section entitled “What is Excluded?” below, AVL warrants to the original 
purchaser of any accessory, loom upgrade parts, or loom replacement parts (the “Additional Part”) that 
are sold by AVL that such Additional Part will be free from defects in materials and workmanship for 
ninety (90) days from the date of purchase. In the event that any Additional Part is physically damaged or 
physically defective and if such defective Additional Part is returned to AVL within ninety (90) days of the 
date of purchase, AVL will provide a replacement Additional Part at no charge. The sole remedy for this 
warranty shall be limited to the replacement of the defective Additional Part. You are responsible for all 
shipping charges (including applicable taxes) incurred with returning the defective Additional Part. 
 
All New Products and their components (including replacement Product and its components) are covered 
only for the Original Warranty Period. When the warranty on the original Product expires, the warranty on 
any replacement Product, or components also expires. After two (2) years from the Effective Date, you 
pay for any replacement or repair, including all parts, all labor and shipping charges (including applicable 
taxes). 
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Your warranty does not cover: 

1.Labor charges for installation or set-up of the Product, as well as any labor charges required to 
install, disassemble, troubleshoot, or reassemble the Product. 

2.Any taxes imposed on AVL for Product replacement or repair under this warranty. 

3.Installation, performance of, or repair of: cabling, electrical, or accessory attachments used with the 
Product. 

4.Product replacement or repair because of misuse, accident, repair by any party other than AVL, or 
other cause not within the control of AVL. Please note that removing any parts from the Product for any 
reason voids the warranty. 

5.Incidental or consequential damages resulting from the Product. 

6.A Product that has been modified or adapted to enable it to operate in any country other than the 
United States or any repair of Products damaged by these modifications. 

7.Electrical and pneumatic components, each of which carries a one (1) year warranty from the 
Effective Date. 

8.Jacquard components function beyond 98%. A Jacquard module is considered to be operating within 
specification if 98% of all hooks are operating as commanded. 

9.Computing equipment, such as a Personal Digital Assistant or a Personal Computer, which are 
manufactured by a third party(ies) and which may be under warranty through the original manufacturer. 
AVL is not responsible for any warranty coverage that may be offered concerning these products and 
you must contact those manufacturers directly regarding any available warranty coverage. 

The performance or functionality of any software that is sold either together or separate from the Product. 
The AVL warranty covers only defects in the Software Media, namely the CD-ROM media such as a 
broken CD-ROM or a defect in the CD-ROM that would prevent the CD-ROM from being read by your 
personal computer's CD-ROM drive.. 

AVL Returns Policy 

Any order that has left AVL in transit to the customer is considered fulfilled. 
Parts and accessories not covered under warranty must be returned to AVL 
within 60 days from the date of shipment from AVL. The purchase price of 
the item(s) is refundable less a 15% re-stocking fee based on the total 
purchase price. No refunds will be given on shipping or handling. The buyer 
is responsible to return the merchandise in "as new" condition at their 
expense. Any item received showing wear or damage is not eligible for 
return and will be promptly returned to the customer COD unless some other 
arrangement is made. Looms and custom-made items, special order items, 
parts made for pre-1998 looms, used and reconditioned items are not 
eligible for return.


